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Summary of the Axxon PSIM utilities

Additional Axxon PSIM software utilities are separate software applications intended to perform additional operations when setting up
and working with Axxon PSIM software. This document describes the following utilities:

The utility for reading video capture card code and dongle

Converter.exe utility for converting video and audio archives

Tweaki.exe utility for advanced setup of the Axxon PSIM software system

The utility for collecting configuration data on servers and RWS for the Technical Support
The Fps.exe utility for productivity estimation

The SignCheck.exe utility for checking the authenticity of exported frames

The Convert.exe utility for correcting modification dates of video archives

The ddi.exe utility for editing database templates and external settings files

The Arpedit.exe utility for creating user dialog windows

10. The idb.exe utility for converting databases, selecting database templates and making backup copies of databases
11. Configuration check tool

12. Index.exe utility for reindexing archive files

13. The shedule.exe utility for creating a replication query file

14. The Axxon Player utility for viewing and converting the video archive

WoONObWD



The utility for reading video capture card code
and dongle



The purpose of the CodeReader.exe utility

The CodeReader.exe utility is designed to read the dallas code of the cryptochip (chip) of the video capture card, which determines the
card type, HID of computer and the number of the Guardant dongle.

(D Note.

For proper operation of the utility Axxon PSIM™ is to be shut down.



Starting and shutting-down the utility

To start the CodeReader.exe utility, do one of the following:

1. Start the utility from the Windows taskbar. Click Start, then All Programs, then Axxon PSIM, then Tools, then Read
hardware codes. The CodeReader.exe utility is available for the following types of Axxon PSIM™ installation: Server and

Remote Admin Workstation.
- ) Microsoft OFFiceL‘nﬂ Outlook Express

d Advanced settings utility
Create dialog windows

b!’ ‘Wideo player and file converter
[] Check digital signature

.. Remate Assistance
ws .
== Microsoft Offics &% yindaws Media Player

3 ‘Windows Messenger

@ Adabe Reader ; D’& Windaws Movie Maker [ Fpstest
- @ Skype L4
‘\. Intellect I ACD Systems 3 Read Matrix codes
— @) mozilla Firefox ™ Restore file system indexes

s

‘..E Microsoft Office @ Google Chrome % Search for IP devices
. .@ ONC-CKA-MCS » @ System configuration
;ﬂ Dr.Web Scanne @ Dr.Web Enterprise Suite » ) ACS-SFA-PSS » 41 update DB

@ McAfes Security Scan Plus 3 .@ Help ¥ [B Axcxon player

@ Drophosx 3 E Restare file system indexes {full mode)

@ Dr.\Web Scanner Collect system's data
|7 daPDF 7 ¥ @y Inkellect

@ Microsoft SQL Server 2008 R2 v BES] 1TV EXPERT

All Pragrams @ Adobe Reader X1 ﬁl Remave

Log off @Shut @s Reports subsystem
2. Start the utility from the Tools folder of the Axxon PSIM folder. Example: C:\ Program Files\Axxon PSIM\Tools\CodeReader.
exe.

The Code Reader dialog box will open.

D5 Code Reader x|

0157
CO0e4FBB3BZ

To shut down the CodeReader.exe utility, click the EI button.
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Using the CodeReader.exe utility

The CodeReader.exe utility allows determining the type of installed video capture card by its dallas code(s), HID of computer, as well
as the number of the Guardant dongle. To read this information, start the utility (see the Starting and shutting-down the utility
section). The type of video capture card, its dallas code(s) and the number of the Guardant dongle and HID will be displayed in the
Code Reader dialog box.

D5 Code Reader x|

?0019D52FDDBFCY7AOC IFASESDFC9A96 1AZ2BDES1363F822FFE5
KB94370FF IEGSFECYCDSE707 1IBFCCAASDADIDEY31009ABAC32
FC36F3251A%ARE16858868032D039D3625BC5E1CEY 1EC1050C
4032B49C72D7D176BF60908CACS932FBF6B4EYEDY 15D 24 3C04A
OFD32189ACF3931494E42088FD255FE9F 941A0EGB17D0ACTDE  |—
ADRECFA99048EDAADDLI3IS7CASEYE1B06248909C12CE30D8FB
D17ESADIEASOGS 107 2FSDCF7CB4F3563262B232EF4EBCB4772
h9032245CE2DDEE154002C610F3781D65806EB70962459CA12E
A OESCA466634FFBE1ABE 14F6F 15 1ESS5B6RAACE1048F3350DDD
SERYA417EBDF4375E242AD4888B8E84E974DAY25357B8BDODD
[FICF9ARCDE7 9674687 10C3F4A9230477C09D 324389447 7CEBLF
BEGEF41EOOBESFEC42D917615FE10RE35038F32C5C4893B3A582
.425747532383803F51D67238FDB5051974555B81F802285FDjj:J

»

The number of dallas codes depends on the number of chips on the video capture card. Figure shows that the FS6 card with 4 chips
has been used.
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Portable version CodeReader_portable.exe

The portable version of the utility for reading the video capture card codes and dongles is the executable file CodeReader_portable.exe.

This file can be downloaded from the official AxxonSoft website.

The CodeReader_portable.exe file can be launched on any computer even without Axxon PSIM installed.

Attention!

For the portable version of the utility to operate, you need to install the latest versions of the Visual C++ redistributable

packages for Visual Studio.

To check the availability of the Visual C++ redistributable packages for Visual Studio, select Start -> Control Panel ->

Programs -> Programs and Features.

[3' Programs and Features

> Control Panel » Programs > Programs and Features v

<« + 1@

Control Panel Home .
Uninstall or change a program

View installed updates

!; Turn Windows features on or

off Organize ~

~

Name

- O

[$] Search Programs an

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Publisher

/E Microsoft Visual C++ 2005 Redistributable

[®] Microsoft Visual C++ 2008 Redistributable - x64 9.0.30729.17
[ Microsoft Visual C++ 2008 Redistributable - x86 9.0.30729.17
[ Microsoft Visual C++ 2010 x64 Redistributable - 10.0.40219
Microsoft Visual C++ 2010 x86 Redistributable - 10.0.40219
IﬂgMicrosoft Visual C++ 2013 Redistributable (x64) - 12.0.30501
ﬂMicrosoﬁ Visual C++ 2013 Redistributable (x86) - 12.0.30501

]@Microsof‘t Visual C++ 2015-2019 Redistributable (x64) - 14.29....

Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation

Microsoft Corporation

Microsoft Visual Studio Code {(User)
l’ig-.‘Microsoft Visual Studio Installer
v Microsoft Visual Studio Tools for Applications 2017
@} Microsoft Web Deploy 4.0
I Movavi Screen Recorder 22

<

Currently installed programs Total size: 17,8 GB

107 programs installed

8]

\ﬁfv‘licroso& Visual C++ 2015-2022 Redistributable (x86) - 14.31....

Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Movavi

X
P

If there are no redistributable packages, you can download them from the official website at: https://learn.microsoft.com/en-
us/cpp/windows/latest-supported-vc-redist?view=msvc-170, or install the file that is available in Axxon PSIM installation
directory in the Redist -> Dotnet4.5 folder.

The purpose and interface of the portable version, as well as the procedure for working with it are similar to the standard version of
the CodeReader.exe utility — see The utility for reading video capture card code and dongle.
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Converter.exe utility for converting video and
audio archives
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The purpose of the Converter.exe utility

1 Important!

Correct operation of the Converter.exe utility on Windows 10 and newer OSes is not guaranteed.

The Conveter.exe utility is designed to play video and audio archives, and to convert them to standard formats: MPEG, DivX, etc.
Besides video and audio playback, Converter.exe utility is used for:

1. Converting audio and video files.
2. Copying the files from the archive to another folder with no data loss.

G) Note.

If video and audio were synchronized at the time of recording, the converted video file will contain sound track.

The utility can be started from the Tools folder of the Axxon PSIM program folder or from the Start menu: Start -> Programs ->
Axxon PSIM -> Utilities -> Playback and Conversion.

The utility dialog box is shown in the figure.

P Archive Converter O x
o | =

B || sj19/2022 || 421:56pM = | 8j19/2022  ~| | 4:21:56PM = BB
|Camera j | j & Dﬁ“
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Starting and shutting-down the Converter.exe
utility
To start the Converter.exe utility, do one of the following:

1. Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Video player and file

converter. The Converter.exe utility is available from the Start menu with the following installation types of the Axxon PSIM
software: Server, Remote administrator workstation, Remote client.

IQ' Ason PSIM

Programming guide

Programming guide (1Script)

Read hardware codes

Registry keys reference guide

Remove

Reports subsystem

System configuration

Titles database update

Update DB

Video player and file converter
XML-file parameters reference guide

£ Type here to search
2. Start the utility from the Tools folder of the Axxon PSIM program folder. Example: C:\Axxon PSIM\Tools\converter.exe.

Archive Converter dialog box will open.
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B2 Archive Converter O e

2% | =|'a
B |[sno2z ~|[azussem = [sromzz  »|[ s2useem = B
[Camera A Halv«rnmy &cd

To close the Converter.exe utility, either click the cross button in the top right corner of the dialog box, or press Alt+F4 on the
keyboard.

16



Converter.exe interface
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The Archive's Converter dialog box

The dialog box of the converter.exe utility is shown in the figure.

=181
'.J:'

..
o
1601

Beuyi 3
Fini :

I

o, | = | ¥ | =
x| | 2 =
% |[16.01.2000 ][ i41:27 = 5 [1e.00.2000 ][ si4ei0s = B
amers =]z =]\ AU D1 WD G

The Archive's Converter dialog box comprises of the following elements:
1. The screen to play back recordings (1);

2. The control panel for video and audio recordings playback (2).
The elements of the control panel are described in the table.

10 8 10

e =YE) 12

Iy

11

3 16.01,2009 = || %4127 16.01.2009 || 9:46:06

(> | : P =) ®.C
4 5 6 7 13 14 15

4 4

N2 Element Description
name

1 Recording Fields for entering the approximate start date and time of the video or audio recording

start date
and time

2 | Recording Fields for entering the approximate end date and time of the video or audio recording

end date
and time

3 | Go to first Buttons for quick moving of the slider to the beginning or the end of the recording

/ last
frame
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10

11

12

13

14

15

Device

Device
number

Search

Playback
panel

Time scale

Export
setup

Exported
recording
limits

Hide/show
the list

Add to list
Print frame

Frame
export

Export to
AVI or
archive

Drop-down list field for selecting the device (camera, microphone), for which the recording should be found in the
archive

Drop-down list field for selecting the number of the device, for which the recording should be found in the archive
Button for starting the search of recordings in the archive of the chosen device. The recordings are searched in the

entire archive of the device. After the search is completed it is possible to specify the approximate beginning ang
end date and time for required recording

The panel contains typical standard functions (from left to right): backward, play, pause, stop, forward
The scale allows monitoring the playback progress and moving between the frames. To move between the frames,
drag the slider or use the playback panel buttons in a per frame playback mode

The button for opening the Export Setup dialog box

The buttons for setting the first and the last frames of the exported record

The button for hiding and showing the list of selected recordings

The button for adding the selected recording (recording segment) to the list
The button prints the current frame

The button exports the current frame in a specified format. A dialog box opens for selecting the folder on the disk
and entering the file name

The button for starting the export of the recording (a recording segment) in the specified format. A dialog opens
for selecting the device name, which made the recording. On export start, a folder is created for saving the
exported recordings (by default, C:\Backup)
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The Export Settings dialog box

To open the Export Settings dialog box, click the ﬂ button in the Archive's Converter window. The Export Settings dialog box
will open, allowing to specify export parameters.

FE Export Settings >
Choose folder

Destination | BEcEiame o |

Volume Size, MB | 650

Frames per second |Real'l'|me j

(" Native Archive {* AVI File

[ Mative Format Iv Break To Alarms
Frame Export

{~ Bitmap ] Quality: 80 100
{* Jpeg I
Compression

Video |Full Frames (Uncom  Audic | PCM, 8.000 kHz,

Titles
Point Of Sale ~| [ Mame, Date Time
x |5 v|s w|wo H|10 Font
Screen
[v Overlay v Keep Aspect Ratio

[~ AlwaysOnTop ™ Spiit AVIFiles
[ Digital signature

JK
No Para Field Description F Default Value range
mete type o value
r r
name m
at
The Choose folder group
1 | Destin Type @ Type-in the folder on the disk to store the exported files (by default the Backup - - -
ation -in folder is created on disk C:)
the
value
2 | Volum Type | Type-in the maximum value of the volume (file) size containing one or more MB 650 0 to 2000 MB
e -in recordings.
Size, the
MB value  If the size of recording for export exceeds the set one, then it will not be split.

When the recording is added to the volume, the size of recording is expected to equal
the mean value of sizes of all added recordings. A new recording is added to the
volume if it does not exceed the volume size. A real size of recording can differ from
the assumed one, therefore the volume size can exceed the assumed one.

If the Break To Alarms checkbox is checked, each volume will contain one recording
only. The field is disabled if the Native Archive parameter is activated
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10

11

12

13

Frame | Selec

sper tin
second a
drop-
down
list
Native | Selec
Archive ta
radio
AVI -
File button
Break | Chec
To kbox
Alarms
Native | Chec
Format kbox
Bitmap Selec
ta
Jpeg | radio
button
Quality  Set
the
slider
Video @ Click
the
button
Field Not
next to
to the be
Video  edited
button
Audio | Click
the
button
Field Not
next to
to the be
Audio | edited
button
Overlay Chec
kbox

Type-in the amount of grooming of the video recording

If the Native Archive radio-button is selected, then archive fragments will be
exported keeping the creation time, but with no AVI conversion. If the AVI File radio-
button is selected, then the fragment is converted to the AVI format using the
specified codec

The checkbox is for selecting the way of storing the archive export fragments to
volumes (files of specified size): the recordings for each alarm will be saved to
separate volumes (files)

If the Native Format checkbox is checked, then video recordings are exported to AVI
file without recompression, i.e. in the same format as in Axxon PSIM archive. To
playback these AVI files on the computer without Axxon PSIM software package
installed, install components from Axxon PSIM distributive beforehand:

1. \Redist\VC2005_SP1\vcredist_x86.exe
2. \Redist\CamMonitor\CamMonitorInstaller.exe

Note. To playback AVI files use Windows Media Player

The Frame Export group

If the Bitmap radio-button is selected, then the file is saved in Bitmap format. If the
Jpeg radio-button is selected, then the file is saved in Jpeg format

The parameter specifies the quality level of the exported file. The value of 100%
results in no quality loss

The Compression group

The button is for selecting and setting up the video codec used to compress video
recordings. If the Native Archive radio-button is selected or the Native Format
checkbox is checked, then this button is disabled

The field shows the info on selected video codec. If the Native Archive radio-button
is selected, then this field is disabled

The button is for selecting and setting up the quality of the exported audio. The Nativ
e Archive radio-button is selected, then this button is disabled

The field shows the selected audio format

The Screen group

If the Overlay checkbox is checked, there is DirectDraw conversion
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fps RealTime 0.5; 1; 3; 5; 15; 30;

- | AVI File

- | Uncheck
ed

- | Uncheck
ed

% 80

- Full
Frame
(Uncom
pr-
essed),
Quality:
0

- PCM,
8000
kHz; 16
bit;
Mono

- Checked

RealTime

1. Native Archive
2. AVI File

Unchecked - the file
(volume) will contain a
fragment of the size
specified in the Volume
Size, MB field

Checked - the volume
will contain a fragment
related to one alarm only

Unchecked - Axxon
PSIM archive is
exported to AVI file with
recompression

Checked - Axxon PSIM
archive is exported to
AVI file without
recompression

0 to 100

The list of codecs found
by the utility

The list of quality levels
detected

Checked - use DirectDr
aw for conversion

Unchecked - do not use
DirectDraw for
conversion



14 Alway Chec @ If the Always On Top checkbox is checked, then Converter window is always over - Uncheck ' Checked - the window
s On kbox ' all other windows ed is displayed on top
Top

Unchecked - the

window is not displayed

on top
15 Keep Chec | If the Keep Aspect Ratio checkbox is checked, the aspect ratio of Converter - Uncheck ' Checked - 3:2 ratio is
Aspec  kbox | window is fixed ed kept when the size of
t Ratio the dialog box is
changed

Unchecked - 3:2 ratio is
not kept when the size
of the dialog box is

changed
16| Split Chec @ Activates export of selected video recordings to the separate AVI files. -  Checked ' Checked - video
AVI kbox recordings are exported
files to the separate AVI files
Note. If the checkbox is not checked, video recordings from one camera are exported Unchecked - video
to one AVI file recordings are exported

to one AVI file

17| Digital  Chec @ Activates adding digital signature that is used for checking frame authenticity to - Uncheck ' Checked - digital
signat = kbox @ exported frames. ed signature is added
ure
Note. Checking frame authenticity is performed using SignCheck.exe utility (see The Unchecked - digital
SignCheck.exe utility for checking the authenticity of exported frames and video signature is not added

recordings section)

If a microphone was selected as a device in the dialog box of Converter.exe utility, only the Audio button and the Screen group are
enabled.
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A dialog box for choosing the video codec

The Video button in the Export Setup dialog box opens a dialog box for choosing a video codec to be used for video compression.

Compressor:

Choose Destination Video Format 4

|I"-'1i::n:|su:|ﬂ Videao 1

Compression Quality: 22 :
j j Corfigure...
About

oK |
j Cancel

No Para Field
mete type
r
name

1 | Comp | Select
ressor | from
drop-

down list

2 Comp Drag

ressio | the
n slider
quality
3  Config | Click
ure the
button
4  About  Click
the
button

(D Note.

Description

The button allows selecting and setting up the video codec used to convert and
compress the video image

The slider allows setting the compression level. The zero position of the slider
represents the highest compression and lowest quality. Changing this parameter is
enabled if the codec is selected in the Compression Program field

The button opens the settings panel of the video codec. See the codec manual for
details

The button opens an information box with codec details

If AVI format is used, the resultant file size should not exceed 2 GB.
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0 to 100



A dialog box for choosing the audio format

The Sound button in the Export Setup dialog box opens a dialog box for choosing an audio format.

Mame:

Choose Destination Audio Format ot

T - | Save .. | |

Format: |F'C|"-"| j
Attributes:  {8.000 kHz. 16 Bit. Mano 15kb/sec  +|
QK | Cancel |
No Param Field type Description
eter
name
1 | Name Select from | The field allows choosing the name for the selected audio format
drop-down
list
2 Format @ Select from ' The field for selecting the format
drop-down
list
3 Attribut | Select from | The list of sound characteristics: playback/recording frequency
es drop-down (8000 kHz), digitizing level (8, 16, etc bits), channel type (mono
list /stereo)
4 | Save Click the The button allows creating a unique name for the selected format.
as... button To save a format under a unique name:

1. Select Untitled in the Name field.
2. Select the values in the Format and Attributes fields.
3. Click the Save As button

4. Enter a unique name in the Save This Format As field and
click OK.

The newly created name will appear in the Name drop-down list.
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Using the Converter.exe utility
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General description of the Converter.exe utility

The Converter.exe utility is designed to convert and play back audio and video recordings from the archive and save them to a
specified folder.

Using the Converter.exe utility includes:

Starting the utility (see Starting and shutting-down the Converter.exe utility).

Selecting an archive (see Selecting an archive to be played or converted).

Finding a recording in the selected archive (see Selecting an archive to be played or converted).
Playback of the recording (see Recording playback).

Finding the required recording fragment or frame (see Searching for a video recording).

Setting the export or conversion parameters (see Converting video and audio archives to AVI files).
Exporting the fragment or printing the frame (see Exporting recordings and frames).
Shutting-down the Converter.exe utility (see Starting and shutting-down the Converter.exe utility).

NoUnhwNH
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Selecting an archive to be played or converted

To search an archive for a recording, do the following:

1. Select the device the recording was made by, and its number (1).
2. Click the Search button (2).

3. Select the location of the archive (folder with archives for specific date and time) on an appropriate disk.

Parze Drives/Faolder n

Password I s i J

( == Local Disk (C:)

D# DVD Drive (D)
] w Share (WW172.19.2.30) (Z:)

S

4. Click the —| button.
5. Specify the time limits in the date/time fields (3).

The first frame of the required recording will be displayed in the video playback screen.
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0)

0)

Note.

In case of searching for an audio recording, no visible signs of finding the recording will be shown. To check that a recording
was found, play it.

Note.

Speed of records search directly depends on their number. The search process can take a lot of time if the archive depth is
rather big and reading is performing from the network disk.

Note.

If video files that are to be opened were not recorded, but copied, then start the Convert.exe utility to open the archive (see T
he Convert.exe utility for correcting modification dates of video archives section):

® If the archive is created in the same time zone as it is viewed, then start the utility with the fullmode parameter:
convert.exe fullmode

® If the archive is created in different time zone than it is viewed, then move the archive to the current time zone by
starting the utility with the following parameters in the command prompt:
convert.exe fullmode TZ +hh:mm
where +hh:mm is the time shift between the current time zone and the time zone of the archive.

Otherwise, the folders with video files fail to open.
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Searching for a video recording

After the approximate time interval is selected using the date/time fields, and the required archive is found, it may be necessary to
find a particular fragment or frame to be played or exported.
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Searching for a fragment in a recording

To find the required video fragment in the selected recording, do the following:

1. Click the Play (J) button in the playback control panel.

2. When the required fragment appears, click the Pause (J) button.

3. Click the Fragment Start (J) button to make the current frame the start of the fragment.
4. Click the Play (J) button in the playback control panel.

5. When the required fragment ends, click the Fragment End (ﬂ) button to make the current frame the end of the
fragment. All subsequent frames will be omitted.

The resultant recording fragment will then be available for conversion or export, maintaining the format and the creation date.
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Searching for a frame in a recording

To find a particular frame in the selected recording, do the following:

1. Click the Play (ﬂ) button in the playback control panel.

2. When the required frame appears, click the Pause (M) button to enter the per frame playback mode.

(D Note.

If the recording is to be played back in the per frame playback mode starting with the first frame, then click the Pause

(ﬂ) button instead of the Play (ﬂ) button.

3. Keep clicking the Fragment Forward (M) and Fragment Back (ﬂ) buttons, to browse the frames until the required
frame appears on the screen.

The resultant frame may be printed or used as a starting frame for a fragment (see Searching for a fragment in a recording section).

(D Note.

To quit the per frame playback mode, click the Pause (ﬂ) button once more.
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Recording playback
The recording selected by date and time, can be played in Converter.exe player using the playback control panel.
) nm

The panel contains five control buttons (left to right on the figure): Back, Play, Pause, Stop, Forward, allowing to play, pause, stop
and browse the records.

1. If the Stop button is down (clicked), then it is possible to move between the recording segments by clicking the Forward or Ba
ck buttons. The recording segment means one of the following:
® a segment of video recording between the commands to start and stop recording if the recording was initiated
manually (for example, via a script or the camera's context menu);
® a segment of video recording between the beginning and the end of the detection tool triggering, taking into account
the periods of pre- and post-recording in case the recording was initiated by any detection tool.
2. A short press of the Play button starts playing the recording segment from start to end. If the recording contains several
recording segments, the Play button should be clicked to play each of them.
3. To play a record consisting of several segments without stopping, press and hold the Play button for 1-2 seconds. The button

then changes its appearance from ﬂ to & . To stop playback, click Stop.

4. To play the recording in the frame-by-frame mode: a) click Play, b) click Pause, c) keep clicking Forward or Back to view
frames one by one.

5. To view the recording segment in accelerated mode click the Play button and then click the Forward to accelerate twice
relatively the previous speed. The current playback speed is displayed in titles above video image.

6. To view the record section in slow motion, click the Play button and then click the Back to slow down twice relatively the
previous speed. The current playback speed is displayed in titles above video image.
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Converting video and audio archives to AVI files

Video and audio archives are converted into AVI format according to Converter.exe settings, using the Export Setup dialog box. The
level of compression of the exported recording is determined by the following parameters:

Frames Per Second parameter - setting the parameters of the recording grooming;

1.
2. Video button - selection of the video codec, in case of video archive export;
3. Sound button - set the sound quality parameters (frequency, bitrate, etc), in case of audio archive export.

@ Note.

If AVI format is used, the resultant file size should not exceed 2 GB.
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Exporting recordings and frames

Export of the recordings is one of the main functions of the Converter.exe utility. There are two ways of exporting records from an
archive:

1. Export to AVI option converts (compresses) a recording and breaks it down into volumes (files of the size specified in the
Export Setup dialog box).
To export the recording as AVI, do the following:
a. Find the recording in an archive (see the Selecting an archive to be played or converted section).
b. In the Export Setup dialog box, select the Export to AVI radio-button.
c. Click the Video or Sound button to specify the conversion parameters. Click the OK button.

d. Click the Export to AVI/Archive button (IEI) to start exporting.
e. Enter the name of the device folder to save the recording to (1), then click Continue ( 2).

Enter Camera Mame

Continue

The export progress will be shown in the title bar of the Converter.exe window.

8 19-Aug-22 04:31 P o X

2=

. | )
B || srof022 || 4200 o [ 89022 || asezerm = )

]Camera | ]1 BT Il AP & @ O

The title bar will read Complete, when exporting is completed. To verify the results, open the Backup folder and find
the file named after the device from which archive the recording was exported.
2. The Export to Archive option allows copying the files from an archive to another location on the disk with no conversion,
maintaining the recording creation date and an option for breaking it down into volumes.
To export a recording in the same format as it is stored in the archive, do the following:
a. Find the recording in the archive (see the Selecting an archive to be played or converted section).
b. In the Export Setup dialog box, select the Export to Archive radio-button.
c. Specify volume size in the Export Setup dialog box. Click the OK button.

d. Click the Export to AVI/Archive button (IEI) to start exporting.
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(D Note.

If AVI format is used, the resultant file size should not exceed 2 GB.

The Converter.exe utility allows exporting frames into bitmap and JPEG formats. Do the following:

1. . Find the required frame (see the Searching for a frame in a recording section).

a
b. In the Export Setup dialog box, specify the parameter values in the Frame Export group. Click the OK button.

c. Click the Export Frame button (@).
d. Specify the location to save the exported file to in the Save As dialog window.

B Save As >
Save in: I I"E'| Documents Lj e R
ﬁ Mame - Date modified Type
. Axon PSIM 8/19/2022 4:32 PM File ft
Quick access Y
Backup 8/15/2022 5:49 AM File f
7 4 5QL Server Management Studio 8/18/2022 12:38 PM File fo
Desktop Support 8/19/2022 4:08 PM File fe
= Wisual Studic 2017 8/18/2022 12:38 PM File fu
|
Libraries
This PC
b 1 2 3
Metwork
£ l >
File name: uam 1 (19-08-22 16291 0) _'_1 Save |
Save astype: JJpeg Files (" jpa;” jpea) ‘:..l Cancel

The file name will be generated automatically in the following format: 1) name and number of the camera where the

frame comes from; 2) creation date; 3) creation time. The file extension corresponds to the file format selected in the E
xport Setup dialog box.

e. Click the Save button.
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Using a command prompt to work with the
Converter.exe utility

Video and frames can be exported with the help of a command prompt using the following commands:
Converter.exe Disc:\File, Number_Cam,StartDate StartTime,StopDate StopTime,CameraName

Converter.exe Disc:\File, Number_Cam,StartDate StartTime,,CameraName

@ Note.

If StopDate and StopTime parameters are not specified, then ',” is to be specified instead.

The table describes the command parameters.

Parame Description

ter
Disk Disk for storing exported files
File Name of a catalogue or file.

Note 1. If the catalogue or file specified in the command does not exist, it will be created automatically.
Note 2. To export archive (video record in the original format) only catalogue name is to be specified.

Number = Number of a camera which performs the recording
_Cam

StartDate Date of record start (dd-mm-yy)
StartTime Time of record start (hh:mm:ss)
StopDate  Date of record end (dd-mm-yy).
Note. Parameter is not in use while exporting the separate frames
StopTime Time of record end (hh:mm:ss)
Note. Parameter is not in use while exporting the separate frames

Camera | Name of the camera that is to be displayed in the titles on the exported video, as well as the name of the folder created
Name in the specified export folder used for storing exported files

The example of using the command prompt to export files is shown in the figure.
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BN Select Ch\Windows\System32\cmd.exe i O %

ogram Fi A verter.exe ( & rt . jps 2 Camer

ogram

As a result the “export” folder containing the exported files is created on the local disk “C".

|—_I= Ei + | Export

Hﬁ__ﬁe Se '-:’]iy]\-'

e w A » ThisPC » Local Disk (C:) » Export 3 " '

7 Cuick access

[ Desktop

4 Downloads

= Documents -

= Pictures

Intellect Builds
"} Camera 1 export export

Editing Axxon PSIM

Extracting event pre

Fps.exe

Synchro source

@ OneDrive
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Printing a frame

To print a frame, do the following:
1. Find the required frame (see the Searching for a frame in a recording section).

2. Click the Print Frame button ( % )-
3. A standard dialog box for printing and printer setup will be opened.
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Exporting video with titles

Video with titles is exported as follows:

1. Run the Converter.exe utility (see Starting and shutting-down the Converter.exe utility).

2. Call for Export Settings dialog window in the opened window of Converter.exe utility and set its groups Choose folder, Fram
e Export, Compression and Screen (see. Interface description of The Export Settings dialog box).

3. Set the titles displaying in the Titles group in the dialog window Export Settings; table shows parameters description of the

given.

FE Export Settings *
Choose folder

= |

Destination B D

Volume Size, MB ] 650

Frames per second JReaI'I'ImE LJ
{* AVI File
¥ Break To &larms

" Mative Archive
[T Mative Format

Frame Export

(" Bitmap s

] Quality: 80

* Jpeg |

Compression

Videa [Full Frames {Unn:urr Audio F‘CM,E.DDHEH:,

Titles 1 Vi

Point Of 5ale | [ MName, Date Time 4
Jx|s v|ls w|wo HJ100 Font
Screen

v Overlay ¥ Keep Aspect Ratio

[ always On Top Iv split AVI Files

[ Digital signatu

igital signature K

N2 Paramet Parameter description Value range

er name

1  Point of Name of cash terminal, titles from which should be laid over the Empty value - titles from all the titrates overlay
sale video recording while viewing and exporting the frames and function.
dropdown | recordings with the help of Converter.exe utility
list No - overlay function is off.

Number of cash terminal (from one and above) -
function of displaying the titles concerning the given
cash terminal.

2 Checkbox = When the given checkbox is activated, lines, containing name Yes - lines, containing name and number of a camera,
Name, and number of a camera, date and time of creation of the given date and time of creation of the given video frame ,
Date, video frame, will be laid over the video recording will be laid over the video recording.

Time
No - lines, containing name and number of a camera,
date and time of creation of the given video frame ,
will not be laid over the video recording.

3  Editing Coordinates and area size, taken by titles in the video recording. From 0 and above.
text Is expressed in percentage relative to the screen size of video
fields X, recording playback Depends on the screen size of video recording
Y, W, H playback.

4  Font Font selection of titles displaying -
button
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(D Note.

If the cash terminal is selected, its value will not be saved with the repeated run of Converter.exe utility. On default
displaying titles from all the titers is set.

4. To apply the settings it is necessary to click OK button. To cancel settings one should click the cross mark in the upper right
corner of Export Settings dialog window.
5. Dialog window of Converter.exe utility for exporting the required file will open in result (see Exporting recordings and frames).

Export of video recordings with titles is completed.
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Tweaki.exe utility for advanced setup of the
Axxon PSIM software system

41



The purpose of the tweaki.exe utility

The tweaki.exe utility is used for configuring Axxon PSIM by editing the sections of the Windows registry, where the setup parameters
for the Axxon PSIM core and modules are stored:

® For 64-bit systems, the sections are HKLM\SOFTWARE\Wow6432Node\AxxonSoft and HKCU\SOFTWARE\Wow6432Node\Axxon
Soft.
® For 32-bit systems, the sections are HKLM\SOFTWARE\AxxonSoft and HKCU\SOFTWARE\AxxonSoft.

The utility should be run as the same Windows user who is used to start Axxon PSIM, otherwise the new settings may not apply. This
is because the choice of the Windows account determines to which registry section the changes will be written.

(D Attention!

Invalid values of the registry keys may lead to the system failure.

The tweaki.exe utility provides the following functionality:

Setup of Axxon PSIM startup (see The Settings panel of the Windows section);
Enabling the debug mode of Axxon PSIM (see Enabling and configuring the debug mode of Axxon PSIM);
Advanced setting of the Video surveillance monitor (see The Settings panel of the Video subsystem section);
Advanced setting of events logging (see The Settings panel of the Axxon PSIM section);
Advanced setting of video signal processing by Server (see The Settings panel of the Video subsystem section);
Advanced setting of distributed architecture (see Extended setup of the distributed architecture);
Changing network names and IP-addresses in the configuration database (see Changing computer names and IP addresses in
the Axxon PSIM configuration database);
8. Limiting the RAM used by MS SQL server (see Limiting memory usage by an MS SQL server);
9. Advanced setting of audio or video recording to an archive (see The Settings panel of the Video subsystem section);
10. Re-indexing audio and video archives (see Re-indexing the audio and video recordings archive);
11. Selecting the analog video output operation mode The Settings panel of the Video subsystem section);
12. Testing the operability of video capture cards (see Testing video capture cards);
13. Advanced setting of PTZ devices (see The Settings panel of the PTZ section);
14. Advanced setting of POS PSIM (see The Settings panel of the POS PSIM section);
15. Displaying versions of Axxon PSIM modules (see The Settings panel of the Version section).

NoahwhN e
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Starting and shutting-down the Tweaki.exe utility

To start the tweaki.exe utility, do one of the following:

1. Start the utility from the Windows taskbar. Click Start => All Programs => Axxon PSIM => Tools => Advanced settings
utility. The tweaki.exe utility is available from the Start menu with the following installation types of Axxon PSIM: Server,

Remote administrator workstation, Remote client.
2. Start the utility from the Tools folder of the Axxon PSIM program folder: C:\Axxon PSIM\Tools\Tweaki.exe.

The Axxon PSIM Advanced Setup dialog box appears after running the tweaki.exe utility.

R Windows
~[> DNS Shel
- [» Visitor management system
- [» Distributed corfiguration ® Explorer
- [» MSDE (MS 5QL) corfiguration () File
Video subsystem
Testing video capture cards

PFT1Z
POIS Autologon

Version Enable
Usemame
[CoMPUTER

Password
|

Domain

Axxon PSIM start service
Restart Aocon PSIM on user login
To restar, the user must belong fo PSIM Users

% Axxon PSIME® Advanced Setup

To shutdown the tweaki.exe utility and save the changes click OK. To shutdown the tweaki.exe utility without saving the changes,

click
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Interface of the Tweaki.exe utility

The user interface of the tweaki.exe utility consists of two interrelated elements:

1. Tree of sections (1).
2. Settings panel for each section (2).

-D

[ Awxon PSIM

Shell
- [ Visitor management system
-[> Distributed configuration ® Explorer
-[» MSDE (MS SQL) configuration () File
[* Video subsystem
[» Testing video capture cards

Autologon

J Enable
Usemame
[comMPUTER

Password
|

Domain

Auxon PSIM start service
Restart Axxon PSIM on user login
To restart, the user must belong fo PSIM Users

% Axxon PSIME Advanced Setup

Sections tree of the tweaki.exe dialog box has static structure and is used for navigation in the utility. To access the settings panel for
the required section, left-click the corresponding tree tab.
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The Settings panel of the Windows section

The Windows section is used to set Windows running Windows OS. The settings panel for the Windows section is shown in the figure.

iz
POS
Wersion

[> Visitor management system

[> Distributed configuration

[> MSDE (M5 SQL) corfiguration
Video subsystem

Testing video capture cards

Shell
(@ Explorer
() File

Autologon
] Enable 3

Usemame

[comPUTER

Password
|

Domain

Awxon PSIM start service
Restart Aoocon PSIM on user login T
To restar, the usermust belong fo PSIM Users

% Axxon PSIME Advanced Setup

The parameters of the Windows setting panel are described in the table.

No Parameter
name

1  The Explorer/
File switch

2  The File field

with

button. Active
for the File
switch position

3 The Enable
checkbox

Fie Description
Id

ty

pe

The Shell group

Set
in
the @ Attention! Disable UAC to run the Axxon PSIM software package as
po | the shell. Configuration of the local security policy is required for full
siti | disabling of UAC in the Windows 8 and Windows 8.1 OS - see OS

on | settings for correct operation of Remote Admin Workstation or Server

Selection of Windows working shell

But  Opens standard Windows window «Open» to select shell file of OS
ton | Windows. Full path to the file is displayed in the field

is

pre

ssed

The Autologon group

Ch  Activates automatic log on of the user to OS Windows
eck
box
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Re
pr
es
en
tat
ion

Bo
ole
an
ty
pe

ef

al
ue

Ex
pl

or
er

No

Value range

Explorer - Microsoft Explorer is
loaded as working Windows OS
shell (corresponds to standard
Windows OS settings).

File - Axxon PSIM starts as a
working shell of Windows OS

The psim.exe or psim_host.exe
executive file is selected as a shell

Yes - automatic log on of the user
is activated

No - automatic log on of the user is
not activated


https://docs.axxonsoft.com/confluence/display/PSIM100en/OS+settings+for+correct+operation+of+Remote+Admin+Workstation+or+Server
https://docs.axxonsoft.com/confluence/display/PSIM100en/OS+settings+for+correct+operation+of+Remote+Admin+Workstation+or+Server

The Username
field

The Password
field

The Domain
field

Restart Axxon
PSIM on user
login checkbox

Ty | Set the username for logging on the OS Windows
pe-

in

the

val

ue

Ty | Set the password for logging on the OS Windows
pe-

in

the

val

ue

Aut | Displays the name of domain server (if there is any), where

om data concerning user account is stored (user name and password)
ati

cally

Set | Specifies the way of restart the Axxon PSIM software installed as a
tin | service on user login

g

che

ckb

oX
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Bo
ole
an
ty
pe

Yes

Up to 64 characters. Depends on
the settings of Windows user
account (stored locally or on
domain server)

8 to 14 characters

Depends on the settings of Window’
s user account (stored locally or on
domain server)

Depends on domain net settings
(net settings of OS Windows
correspondingly)

Yes - the Axxon PSIM software
installed as a service restarts under
the current user if it belongs to the
PSIM Users group

No - The Axxon PSIM software
installed as a service doesn't restart
under the current user even for
users belonging to the PSIM Users
group



The Settings panel of the Axxon PSIM section

The Axxon PSIM section is used for Axxon PSIM advanced setup. The settings panel for the Axxon PSIM section is shown in the
figure.

PTZ
POSs

Axxon PSIM

Yersion

[» Vistor management system

[> Distributed corfiguration

[> MSDE (MS 5QL) configuration
Yideo subsystem

Testing video capture cards

Core IP address

Keyboard prefix 2

127.0.01

| B

Logging subsystem
Debug mode
| Disabled

Time of log keeping (hours):

Keep logs ﬁ
[ Forward to debugger?
Maximum size (MB):

|48

|4 [100

Counters logging period (5):

|60

|5

Path for export of JPG and AV files

(@) Default {fxxon PSIMAExport) g
O Other] 0

[] Receive uncompressed video 1 3
[] Evert protocol over all windows*] 4
] Only local pratocal 1 5

[] Sort tree objects by |D1 6

Overday in ew_xrerrt prgtf:gol

Mone

% Axxon PSIME Advanced Setup

(=

~|21

The parameters of the Axxon PSIM settings panel are described in the table.

No Paramete Method

1

r name

The Core
IP

address
field with

<

button.
Set on the
Client

Keyboard
prefix

of
setting
the
parame
ter
value

Enter
the
value
in the
field
/use
the

<
button

Enter
the
value
in the
field

Description Represe Default value
ntation
Sets the IP address of the Axxon PSIM server to which the 1P 127.0.0.1
psim_host.exe module is connected by default. address
In case of pressing button, IP address of the local
computer is set
Sets the prefix for a special keyboard. When a button is Symbol | —

pressed on this key-board the Axxon PSIM detects when the

button was pressed on this very keyboard

The Logging subsystem group
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[] Record path ] 2

Open folder] 1

[] Disable protocnl1 7
[] Used memory dump’1 8
0Old scripts support 1 g
[ Time synchronization 20
Application lanquage
English (United States)

Value range

Depends on net settings of the
Server. In case of connection failure
dialog window requiring IP address is
displayed

Usually, a tilde (~), code 126



3

10

11

12

Debug
mode

Log-
storing
time
(hours)

Counters
logging
time (sec)

Save logs

Redirect
to
debugger

Maximum
size (MB)

The Defau
It (Axxon
PSIM\Exp
ort)
/Other
switch

The Other
field with

the
button

Open

folder

Record
path

Select
the
value
from
the
drop-
down
list

Enter
the
value
in the
field

Enter
the
value
in the
field

Set the
checkbox

Set the
checkbox

Enter
the
value
in the
field

Set in
the
position

Click
the
button
/enter
the
value
in the
field

Click
the
button

Set the
checkbox

Sets the mode of the Axxon PSIM Debug window displaying List of Starting with weekly
(see The Debug window) available | build 1.0.1.172, the De
modes bug 4 mode is
of Debu  enabled by default.

g Before this build—Disa
window bled is a default mode
displaying

Sets the time of keeping log files Sequence 48 hours

Assigns the time interval in seconds for logging processor Sequence 60

load, memory usage, and disk usage

Enables logs saving Boolean ' Yes
type

Enables the debugger Boolean ' None
type

Defines the maximum size of RAM that log files can use. Log Sequence 100 MB

files are archived after that size is reached

The JPG and AVI files export path group

Sets the folder for exported frames from Axxon PSIM video — Default (Axxon
archive (see Frame export) PSIM\Export)
Sets the path name to the folder, where frames from video Path -

archive are to be exported when the switch is set in the Other ' name

position.

Note. The specified path will be applied to the ExportDir
registry key located in
HKLM\SOFTWARE\WOW6432Node\AxxonSoft\AxxonPSIM\Vide
o (see Registry keys reference guide)

Opens the current folder for frame export - -

The checkbox allows you to prohibit changing the export Boolean ' No
directory when exporting an archive period type

@ Note

The selected value is written to the ExportDirFixe
d registry key located in HKLM\SOFTWARE\WOW64
32Node\AxxonSoft\AxxonPSIM\Video (see Registry
keys reference guide).

No group

48

Disabled—Debug window is not
displayed

Debug 1—Debug window is
displayed and a log file containing
recordings about modules errors is
created

Debug 2—Debug window is
displayed and a log file containing
recordings about modules errors and
alerts is created

Debug 3—Debug window is
displayed and a log file containing
recordings about all the modules
events is created

Debug 4—Debug window is
displayed and a log file containing
recordings about all the modules
events, and also additional menu that
is individual for each module (used by
programmers) are created

>0

Positive whole numbers not less than
60 and zero. If the value 0 is
specified, sensor data is not included
in the log file

Yes—logs are saved

No—logs are not saved
Yes—the debugger is in use
No—the debugger is not in use
>= 100

Values less than 100 Mb are ignored

Default (Axxon PSIM\Export)—
exported to the C:\Users\%current
user name% \Documents\Axxon
PSIM\export\ folder

Other—exported to the selected folder

Yes—export catalogue change is
forbidden

No—export catalogue change is
allowed


https://docs.axxonsoft.com/confluence/display/PSIM100en/The+Debug+window
https://docs.axxonsoft.com/confluence/display/PSIM100en/Frame+export
https://docs.axxonsoft.com/confluence/display/PSIM100en/Registry+keys+reference+guide
https://docs.axxonsoft.com/confluence/display/PSIM100en/Registry+keys+reference+guide
https://docs.axxonsoft.com/confluence/display/PSIM100en/Registry+keys+reference+guide

13

14

15

16

17

18

19

20

2

—-

22

Receive
uncompre
ssed
video

Event
viewer
over all
windows

Only
local
protocol

Sort tree
objects
by ID

Disable
protocol

Used
memory
dump

Support
old
scripts

Time
synchroni
zation

Overlay
in Event p
rotocol

Applicatio
n
language

Set the
checkbox

Set the
checkbox

Set the
checkbox

Set the
checkbox

Set the
checkbox

Set the
checkbox

Set the
checkbox

Set the
checkbox

Select
the
value
from
the
drop-
down
list

Select
the
value
from
the
drop-
down
list

Enables receiving uncompressed video from the Server. As a
rule is set on the Client

Enables displaying the Event viewer window over all windows

Enables logging the events registered in the given computer to
the Events protocol database.

Note. This parameter can be set on the settings panel of the C
omputer object—see Configuring events logging

Enables sorting of objects in the tree by identifier.

Note 1. If sorting by name is chosen, and there are numbers
in the object name, then the objects will be sorted in
alphabetical order. For example, an object with the name "115
" will be above the object with the name "15", because in the
name "115" the second number is 1, and in the name "15"
the second number is 5.

Note 2. This key also affects the sorting of objects in the tree
when adding the objects to a layer in the Map Editor utility

Disables events logging to the Event viewer database on this
computer.

Note. This parameter can be set on the settings panel of the C
omputer object—see Configuring events logging

Enables logging .dmp file with a copy of main memory with
incorrect shutting down at least one of the system modules to
the Axxon PSIM root folder

Enables the support of program tools in Axxon PSIM

Sets time synchronization of all computers in the distributed
system with system time of this computer. Time is
automatically synchronized at midnight every 24 hours or
when Axxon PSIM is started on the Server that is the source
of time synchronization

Sets the overlay mode for processing the video signals that
can be viewed with the help of the Event protocol object

Assigns the Axxon PSIM interface language
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Boolean
type

Boolean
type

Boolean
type

Boolean
type

Boolean
type

Boolean
type

Boolean
type

Boolean
type

Names
of
overlay
modes

Names

of
installed
languages

No

No

No

No

No

No

Overlay 2

Yes—Client receives uncompressed
video from the Server

No—Client receives compressed video
from the Server

Yes—the Event viewer window is
displayed over all windows

No—the Event viewer window is

displayed if a corresponding screen is
selected

Yes—events registered in the given
computer are recorded to the Events
protocol database

No—all required events are recorded
to the Events protocol database

Yes—objects in the tree are sorted by
identifier

No—objects in the tree are sorted by
name

Yes—events are not logged to the
Event viewer database

No—events are logged to the Event
viewer database

Yes—memory dump is created

No—memory dump is not created

Yes—both scripts and programs are
supported

No—only scripts are supported

Yes—synchronization is enabled

No—synchronization is disabled

None—video signals are not
processed by video card

Overlay 1—Direct3D is used

Overlay 2—DirectDraw is used

Depends on the set of installed
languages. See Axxon PSIM Software
System's interface language


https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+events+logging
https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+events+logging
https://docs.axxonsoft.com/confluence/display/PSIM100en/Axxon+PSIM+Software+System%27s+interface+language
https://docs.axxonsoft.com/confluence/display/PSIM100en/Axxon+PSIM+Software+System%27s+interface+language

The Settings panel of the DNS section

The DNS section is used for setting the automatic connection between the Client and reserve video Servers in case of connection loss
with the main Server. In the DNS section, it is necessary to specify network names and IP addresses of reserve video Servers as they
are not listed in the Windows registry by default.

The settings panel of the DNS section is shown in the figure.

Windows

T management system
- [» Distrbuted corfiguration
-[» MSDE (MS 5QL) configuration
Video subsystem

Testing video capture cards

PTZ

POS

Version

System identifier IP address

3

Allow all names

% Axxon PSIME Advanced Setup

The parameters of the settings panel of the DNS section are described in the table.

N2 Param Method for
eter setting the
name parameter value

1 | Syste  Enter the value

m in the field
identif
ier

2 IP Enter the value
addre | in the field.
ss

3 | Allow  Click the button
all
names

{D Note

Parameter description

Sets the network name of the reserve video Server if the connection
with main Server is lost

Sets the IP address of the selected reserve video Server

Automatically adds the computers IP addresses, set in the System
identifier column, to the IP address column if these IP addresses
are enabled and identified

Repr Defa
esent ult
ation value

P -
addre
ss

To delete a specified server, select it in the list (click the row) and press Ctri+Del on the keyboard.
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Value range

Depends on the network
settings of the reserve
video Server

Depends on the network
settings of the reserve
video Server



The Settings panel of the Visitor management
system section

The Visitor management system section is designed for creating common photo database of the Access Manager module (is not
included into Axxon PSIM base configuration, see Creating a single photograph database). In this section it is necessary to specify
netnames of computer where the photos are to be stored. Photos are to be stored in the Person folder (<Axxon PSIM>\Bmp\Person).

(D Note.

The Person folder is automatically created when the Access Manager module is installed.

; [> Windows
= [ Awxon PSIM
e [puIbLS,

Visifor manz

= System identifier
Visitor management system

[> MSDE (M5 SQL) corfiguration
[> Video subsystem
[» Testing video capture cards

% Axxon PSIME Advanced Setup
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https://docs.axxonsoft.com/confluence/display/acfaPSIM100en/Creating+a+single+photograph+database

The Settings panel of the Distributed
configuration section

The Distributed configuration section is for Axxon PSIM common database adjustment when real computer netnames do not
coincide with the names in the database (for instance when the computer with the database is replaced). The section is also used for
adjusting IP-address of selected computer in the database.

The settings panel for the Distributed configuration section is shown in the figure.

[> Version

% Axxon PSIME Advanced Setup

[> Video subsystem
[» Testing video capture cards

 Distributed configuration

Distributed configuration
Select database 1 Use cument DB 2

Available systems:

| System identifier

Mew system ID
[LocaLHosT

[ Update protocal 5
[] Clear protocol § 7
Update DB

Change IP address @ 10 11
~| = 127001 Edit

The parameters of the settings panel are described in the table.

N2 Parameter
name

1 | The Select
database
button

2 | The Use
current DB
button

3 | The Availabl
e systems
table

4  The New
system ID
field with

<
button

Field type

Click the button

Click the button

Automatically

Button is clicked
and value is
selected from the
list/ typed in the
field.

Description Representati
on

Opens the standard Data Link -
Properties dialog box to choose the
database, where netname and/or IP-
address are to be changed.

Selection of main Axxon PSIM database

Displays the list of netnames of -
computers that are in selected database

Specifies a new netname of a computer -
selected in the Available systems table

52

De
fa
ult
val
ue

Value range

Netnames of computers connections
between which are set on the Architec
ture tab

Depends on the current net settings of
the required computer.

If the network name is longer than 15
characters, then first 15 characters
are to be specified as the network
name in this field



10

11

The Update
protocol
checkbox

The Clear
protocol
checkbox

The Update
DB button

The Update
protocol
field

The
dropdown
list with IP-
addresses

Field of
setting IP-
address

The Edit butt
on

Checkbox

Checkbox

Click the button

Automatically

Select from the list

Type-in the value in
the field

Click the button

Replaces the computer’s netname in the
Events protocol table of the selected
main Axxon PSIM database

Boolean type

Clears the event log from the Events
protocol table of the selected main Axxo
n PSIM database

Boolean type

Runs the process of updating the -
selected database in accordance with
given settings

Displays updating process of the -
selected database

The Change IP address group

IP-addresses
of computers
in the selected
database

Specifies IP-address that is to be
changed in the selected database

Specifies a new IP-address to be IP-address

changed in the selected database

Changes the IP-address of the required -
computer in the selected database
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No
ne

No
ne

Yes - computer’s netname is replaced
in the Events protocol table

No - computer’s netname is not
replaced in the Events protocol table

No - the list of registered events is
not cleared

Checked - the list of registered events
is cleared

Depends on the structure of the
selected database and the given
settings

Depends on the number of computers
connections between which are set on
the Architecture tab

Depends on the current net settings of
the required computer



The Settings panel of the MSDE (MS SQL)
configuration section

The MSDE (MS SQL) configuration section is designed for setting the limits of RAM space for MS SQL Server operation with
databases of SQL format. This limitation enhances the performance of the system.

The settings panel for the MSDE (MS SQL) configuration section is shown in the figure.

g [> Windows
= [ Axxon PSIM

[> Visitor management system

MSDE (MS SQL) configuration

Select database Use cument DB

Maximum memary usage (MB)

40596

SOL database size: GB
4

% Axxon PSIME Advanced Setup

The parameters of the settings panel are described in the table.

Neo Parameter
name

1  The Select
database button

2 | The Use current
DB button

3 | The Maximum
memory usage
(MB) indicator

4 | The SQL
database size fie
Id

Field
type

Click the
button

Click the
button

Enter
the
value in
the field

Automati
cally

Description

Opens the standard Data Link Properties dialog box
for choosing the database of MS SQL format the RAM
space for which is to be limited.

Selects the main Axxon PSIM database

Sets the space of RAM in MB for SQL Server operation

Displays the current size of all MS SQL databases on
the Server
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Representation

MB

Positive real number
with amount precision
— two decimals

Def
ault
value

4096

Value range

Depends on full space
of RAM.

Depends on the
capacity of storage
where the database is.



The Settings panel of the Video subsystem section

The Video subsystem section is used for advanced configuration of the video subsystem in order to enhance the performance of Axxo
n PSIM.

The settings panel for the Video subsystem section is shown in the figure.

Windows
Auxon PSIM
[> DNS Ring

[> Visitor management system
[> Distibuted corfiguration me 4
Ly O

Mideo sub:

Rebuild index

QL) configuration i
Frame court i

2 e

Analog video output
Recording time Al “| T
0 B3 Use: virtual grabber §
Restart recording on entering the archive ] Hide mask Q

i 4

[] Automatic font size selection for export

[] Gradual increment of camera tile
[ Swap frame fields 1 4 [] Pause playback at archive entry
] Use PureVideo/CUDA hardware acceleration

Step of digital zoom scale Maximum ratio
of digital zoom

2.00 E{15 16

Cameras without video compression

17

Advanced Setup

The parameters of the settings panel are described in the table.

No Parame Method Parameter description Rep D Value range
ter of res e
name setting ent f
the ation a
paramet u
er value It
v
a
I
ue
1 Ring Enter the @ Sets free disk space; when the limit is reached, the earliest recordings ' MB 5 Depends on the hard disk space
value in will be deleted on loop (see General information on video archiving). 0
the field If two or more disks are used for video archiving, archiving on current 00

disk is performed till there is FreeMbCritical of free disk space (1000
MB by default, see the info on the key in Registry keys reference guide
).

Free space set by the Ring parameter is used for recording temporary
files. This means that when the limit set by the Ring parameter is
reached, the maximum size of the temporary file is Ring (registry key
FreeMb). Video can contain less frames than set by the Frame count
parameter.

Note. Old recordings may get deleted before the remaining disk space
reaches the specified value if the disk space is less than 15000

2 Frame  Enter the | Sets the maximum number of frames in one recording file Fra 1 1500 to 10000. We don't recommend changing the
count value in me | 5 default value
the field 00
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10

11

12

13

Recordi | Enter the

ng time  value in
the field
/select
the value
from the
list

Restart | Enter the

recordi value in

ng on the field

enterin  /select

g the the value

archive  from the
list

Rebuild | Click the

index button

Priority = Select
the value
from the
drop-
down list

Analog Select

video the value

output | from the
drop-
down list

Use Set the

virtual  checkbox

grabber

Hide Set the

mask checkbox

Automa Set the

tic font  checkbox

size

selectio

n for

export

Gradua | Set the

1 checkbox

increm

ent of

camera

tile

Swap Set the

frame checkbox

fields

Use Set the

PureVi  checkbox

deo

/CUDA

hardwa

re

acceler

ation

Sets the length of the file in seconds, restricting fragment’s size not
by number of frames, but by time of its recording

Enables the restart of recording on entering the archive

Deletes the file that stores indexes. After deleting the file, click the Re
build index button to restart Axxon PSIM and create a new file with
updated indexes

Sets the execution priority of all Axxon PSIM processes

Selects the operation mode of the analog output

Allows access to virtual Video capture devices settings in Axxon
PSIM.

Note. Desktop Experience Feature must be enabled when using a
virtual video capture device on server OS and avi files

Disables displaying the video hidden by the motion detection mask.
Video area marked by motion detection mask will be hidden by a grey
fill. This feature works only on uncompressed video from FS or FX
local video capture cards

Enables the relative font size for captions (camera No. and time)
when exporting a frame or fragments of the video archive

Enables a gradual increase of the Surveillance window on the custom
layout by double-clicking the left mouse button. All Surveillance
windows on the layout must be of the same size to ensure proper
operation of the key

Switches Axxon PSIM from basic to additional driver if there are video
artifacts when using the basic driver

Enables PureVideo/CUDA support on the Server when
decompressing video from IP devices if PureVideo HD card of the
second or third generation (NVIDIA VP2 and VP3) is installed. Used to
reduce CPU load due to resources of graphics processor
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Tim
ein
seco
nds

Inte
ger

Na

of
prio
rity
proc
esses

Na

of
avai
labl

mod
es

Bool
ean
type

Bool
ean
type

Bool

type

Bool
ean
type

Bool
ean
type

Bool

type

No

y3Tosso0®

>

Cl

ar

ar

Cl

ar

Cl

ar

Cl

ar

et

Unlimited

0—video fragment that was being recorded at the
moment of entering the archive is forcibly stopped, and a
new one starts. As a result, the user who enters the
archive sees a freeze frame corresponding to the moment
of entry

>0—the recording is restarted when entering the archive,
while positioning in the archive is carried out with a shift
back to the specified value in seconds

-1—recording is not stopped at the moment of entering
the archive

Realtime, High, Above normal, Normal, Below normal, Low

All—video signal from a camera is displayed on a
separate analog monitor

One—video signals from cameras that are connected to
different video capture devices, are displayed on a
separate analog monitor

Set—the Virtual and Virtual bench values are available
from the Type drop-down list on the settings panel of the
Video capture device objects

Clear—the Virtual and Virtual bench values aren't
available for the Video capture device objects

Clear—video hidden by the mask is displayed

Set—video hidden by the mask video isn't displayed

Clear—when exporting a frame, regardless of the video
resolution, the caption size remains constant as set by the
SubtitlesFontSize registry key, see the Registry keys
reference guide

Set—when exporting a frame, the caption size is scaled
depending on the video resolution

Clear—Surveillance window is expanded to the entire
Video surveillance monitor by double-clicking the left
mouse button

Set—by double-clicking the left mouse button, the
Surveillance window is expanded gradually: the first
double-click expands it two times of the initial size, the
second double-click expands it three times of the initial
size, and so on. The Surveillance windows adjacent to it
are hidden on the layout

Clear—Axxon PSIM operates with basic driver

Set—Axxon PSIM operates with additional driver

Clear—PureVideo/CUDA isn't used

Set—PureVideo/CUDA is used
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14 Pause Set the
playbac checkbox
k at
archive
entry

15 Step of Enter the
digital | value in
zoom the field
scale /select

the value
from the
list

16 Maxim | Enter the

um value in
ratio the field
of /select

digital  the value
zoom from the
list

17 Camera  Enter the
s value in
without  the field
video
compre
ssion

(D Note

The Pause button is clicked when entering the archive

Specifies the fractional step of video image zooming

Specifies the maximum value of digital zoom of video image

Specifies the numbers of cameras connected to the video capture

cards with compression. There is no compression for these cameras, i.

e. the compressor settings in Axxon PSIM are ignored

Bool
ean

type

Nu
mbe
rs
with
the
fixe

point

Nu
mbe
rs

Ca
mer

seri
al
num
ber

Cl

00

16

Set—the Pause button is clicked when entering the
archive, you can navigate through the archive using
arrow keys

Clear—the Pause button isn't clicked when entering the
archive

Maximum value depends on the maximum scale of digital
zoom (see 17).

Minimum value is 1.00

1-16

Depends on the number of cameras registered in the
system

Setting the non-zero value to the Recording time parameter does not disable the Frame count parameter. If the values
for both parameters are set, then the file recording will be performed in accordance with the value which comes first. For
instance, if the value of Recording time is equal to 10 seconds and Frame count is equal to 500 frames (by default) and in
10 seconds the fragment consists of 80 frames, then 80-frame file will be recorded.
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The Settings panel of the Testing video capture
cards section

The Testing video capture cards section is designed to test the connection of the cameras to the video capture card.

(D Note.

To use this functionality Axxon PSIM is to be logged off. Otherwise there is “Cards not found” message.

The settings panel for the Testing video capture cards section is shown in the figure.

e [ indowes

[> DNS

- [ Awwon PSIM

D Visitor management system FS 5/5/8/14416 cade:1E4C7
[> Distributed configuration

(> MSDE [MS SGL) configuration Channels state
[\, At b s ko

Testing wideo capture cards l

Channel 3 State 4

[ ‘ersion

Digconnected

Digzonnected

Dizconnected

Disconnected

Dizconnected

Dizconnected

Digconnected

:
2
3
4
5
g
7
g

Digconnected

Digconnected

Digconnected

Digconnected

Dizzonnected

Dizconnected

Disconnected

B

X
X
X
X
X
X
X
X
X
X
X
X
X
X
X

Dizconnected

% Axovon PSTM® Advanced Setup

The parameters of the settings panel are described in the table.

Parameter
name
No
1  The Board
dropdown
list

2 The Test but
ton

3 The Channel
column

4  The State
column

Field
type

Dropdo
wn list

Click
the
button

Automa
tically

Automa
tically

Description

Checking
result:
Success

Representat Defaul
ion t
value

Specifies the video capture card which camera connections List of video -

are to be checked

capture cards

Starts the testing process of the video capture card. The Axxo - -

n PSIM system is to be closed at the time of testing.

The Channels state table

Displays the channels numbers of the selected video capture - -

card

Displays the state of camera connections to the channels of

the selected video capture cards
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Value range

Depends on the number of
installed video capture cards

From 1 to 16

Attach - camera is attached

Detach - camera is detached



The Settings panel of the PTZ section

The PTZ section is used for setting the telemetry control elements.

The settings panel for the PTZ section is shown in the figure.

[ Windows
[ Awxon PSIM
-[> DNS

Delay between commands {ms)

-[» Visitor management system
-[» Distributed corfiguration %}ns}
-[> MSDE (MS 5QL) corfiguration et

[soo00 ]2

Joystick
Sensitivity (1-10)
|2

Axxon PSIME® Advanced Setup

The parameters of the PTZ settings panel are described in the table.

No Parameter
name

1 The Delay
between
commands
(ms) field

2 The Delay
by priority
(ms) field

3 The
Sensitivity
(1-10) field

Field
type

Type-
in the
value

Type-
in the
value

Enter
the
value
in the
field

Description

Sets the delay time between executing the commands for PTZ devices

This parameter is not supported by IP cameras.

Sets the delay time before switch from the PTZ control to a user with lower or
equal priority.

The Joystick group

Sets sensitivity of the joystick: the less value the more sensitivity. If value of
parameter is small then camera will react on even small deviations of the
joystick. If value of parameter is great the camera will stay fixed until significant
deviation of joystick
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Repres De

entation fa
ult
val
ue

ms 250

ms 30
000

Sensitivi | 5

ty in

conditio

nal

units

Value range

No limitations. It is
not recommended
to change the
default value.

No limitations. It is
not recommended
to change the
default value.
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The Settings panel of the POS PSIM section

The POS section is designed for setting the POS PSIM module for controlling cashier operations (is not included in Axxon PSIM basic
version). Detailed information about POS PSIM configuring using the tweaki.exe utility is presented in The settings panel for the POS
sections using the tweaki.exe utility section in the Administrator's Guide documentation for POS PSIM software package.

- [» Windows
- [ fexon PSIM

- [» DNS

- [» Visitor management system

- [» Distributed corfiguration

- [» MSDE (MS SQL) configuration
[* Video subsystem

5 data to fil
[> Testing video capture cards [ Save datatofie
on

Falder: Aocon PSIMYModules'.PosCapture | Open folder
[] Allow to specify recognition settings
[] Convert DOS to Windows codepages
[] Use UTF-8

% Axxon PSIME Advanced Setup
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The Settings panel of the Version section

The Version section provides information about Axxon PSIM software modules: versions, paths to executable files and .dll libraries,
file sizes and dates of creation and modification.

The settings panel for the Version section is shown in the figure.

[> Windows NP
D Aocon PSIM versior
- [» DNS
g‘uﬁsﬂormanagemerrt system File Version Full path Size

[> Distributed corfiguration Y idb exe 1.0.0.280 C:\Program Files ... | 1085024

[> MSDE (MS SQL) corfiguration idb ini Mot found C:\Program Files .. | 1753
[» Video subsystem
(> Testing video capture cards libeay32 dll 102 C:\Program Files ... | 1281024

map.ini Mot found C:\Program Files ... |56

ProfUl5252m10.dIl |2.5.2.0 C:\Program Files ... | 3162112
PSIM.exe 1.0.0.280 C:\Program Fi... 14927360
PSIMRunService... [1.0.0.280 CProgram Files ... | 48128
PSIM_Host exe 1.0.0.280 C:\Program Files ... | 4422656
SlaveSettings xml | Mot found C*\Program Files ... |5

slave_compresso ... | Not found C:\Program Files ... | 533
ssleay32.dil 102 C:\Program Files ... | 278016
SYTIC EXE 1.0.0.280 C:Program Files ... | 2610688
sync.xml Mot found C:\Program Files ... |441
logdnet dil 1.210.0 C:\Program Files ... | 270336
logdnet xml Mot found C:\Program Files ... | 1365508
Mewtonsoft.Json.dll | 9.0.1.19813 C:\Program Files ... | 526336

% Axxon PSIME Advanced Setup
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Typical tasks concerning system extended settings
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Enabling and configuring the debug mode of
Axxon PSIM

On the page:

® Enabling debug mode
® Configuring log file parameters

Debug mode is a special operation mode when the Debug window is open, and is designed for analyzing the progress of Axxon PSIM
software operation and for prompt debugging in case errors occur. Log files are created in this mode—they are stored on the disk for a
specific time period.

W Debug window

Clear Colors Filter [ apply filter [Juse regex | search

Event : SLAVE|DESKTOP-7932GGS |PING |slave_id <DESKTOP-7932GGS >, owner <DESKTOP-7932GGS > module <video.run >,date <27-08-22> ver_type<0>,guid_pk<{E2989C1E-F 125-ED 11-B8DF-BE70F4FEQSAA} =, core_global< 1>, time<14:1!
Event : SLAVE|DESKTOP-7932GGS |PING |slave_id <DESKTOP-7932GG9 > owner <DESKTOP-7932GG9 > module <video.run >, date < 27-08-22> ver _type <0 guid_pk <{35D71631-F 125-ED 11-B8DF-B& 70F4FEQSAA} > core_global < 1>, tme<14:1!
Event : SLAVE|DESKTOP-7932GGI |PING |slave _id <DESKTOP-7932GG9 > ,owner <DESKTOP-7932GG9 > module <video.run >, date < 27-08-22: ver_type <0>,quid_pk<{A2EDC644F 125-ED11-B8DF-BE70F4FEDSAA} = core_global<1, time <14:1
Event : SLAVE|DESKTOP-7932GG9 |PING |slave_id <DESKTOP-7932GG9 > ,owner <DESKTOP-7932GG9 > module <video.run >, date <27-08-22= ver_type <0>,guid_pk <{CBDD4557-F 125-ED11-B8DF-BE70F4FEDSAA} > core_global<1>,time <1411
Event : SLAVE|DESKTOP-7932GGS |PING |slave_id <DESKTOP-79326GGS >, 0wner <DESKTOP-7932GGS > module <video.run >, date < 27-08-22>,ver_type<0>,guid_pk<{A45DF 16A-F 125-ED11-B8DF-BE70F4FEDSAA} = core_global<1>,time<14:1
Event : SLAVE|DESKTOP-7932GGS |PING |slave_id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG9 > module <video.run >, date < 27-08-22> ver _type <0 guid_pk<{F2660075-F 125-ED 11-B8DF-B& 70F4FENSAA} > core_global < 1>, tme<14:17
Event : SLAVE|DESKTOP-7932GG9 |PING |slave_id <DESKTOP-7932GG9 > owner <DESKTOP-7932GG9 >, module <video.run >, date < 27-08-22 ver_type <0>,guid_pk <{7351BABB-F 125-ED 11-B8DF-BS70F4FEOSAA} =, core_global< 1>, time < 14: 1§
Event : SLAVE|DESKTOP-7932GG9 |PING |slave_id <DESKTOP-7932GG9 > ,owner <DESKTOP-7932GG9 >, module <video.run >, date <27-08-22= ver_type <0>,guid_pk < {9849649F F 125-ED 11-B8DF-B870F4FEDSAA} =, core_global< 1>, time < 14: 1£
: SLAVE[DESKTOR-7332GG9 |PING |slave_id <DESKTOP-7932GG9>,0wner <DESKTOP-79326G9 > module <video.run>,date < 27-08-22>,ver_type <0>,quid_pk<{C1907782-F 125ED 11-B8DF-B870F4FE05AA} > core_global< 1>, time < 14: 19

Enabling debug mode

Starting with weekly build 1.0.1.172, the Debug 4 mode is enabled by default. In previous versions, the Debug mode is disabled by
default. To enable the Debug mode, do the following::

1. Shut down Axxon PSIM.

2. Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility)

3. Select the Axxon PSIM node in the tree on the left side of the utility dialog box.

4. Change the parameter Debug mode from Disabled to Debug 1, Debug 2, Debug 3 or Debug 4 (see description of modes
in The Settings panel of the Axxon PSIM section).

5. Click the OK button.

6. Start Axxon PSIM.

The Debug window item will appear in the Axxon PSIM main control menu.

Run

About program...
L3 Debugwindow

System settings

Log off
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7. Select Debug window in the main control menu to open the Debug window. The selected item will be marked with a tick.

=]

Run 5]
ooo

About program...

Debug window

System settings

Log off

To hide the Debug window, select the Debug window item in the menu once more.

(D Note

The debug mode slows the system down and uses a lot of system resources. We strongly recommend to enable debug mode
for debugging purposes only and to disable it when all the settings are completed.

(D Note

Find details in the The Debug window section of The Script object. Programming using the JScript language.

Configuring log file parameters

You can set log keeping parameters both on the Axxon PSIM setting panel in the Tweaki.exe utility (see The Settings panel of the
Axxon PSIM section) and using some registry keys:

1. The Time of log keeping (hours) parameter means the same as DebugTime registry key. It specifies the number of hours
for keeping log files. 48 hours by default.

2. The Maximum size (MB) parameter means the same as DebugSize registry key. It specifies the number of megabytes
provided for log. 100 MB by default.

3. The DebugZipDays registry key enables the logs archiving in the .gz format and specifies the time period for their keeping. 2
days by default.

Log files are rewritten when the maximum of one of the parameters is reached.

When the Debug 4 debug mode is enabled, the video.run log file displays the most detailed information about the file system and
memory usage of each camera every 10 seconds. To reduce the number of info lines,, displayed every 10 seconds, to 6 (this will
reduce the size of the log file), it is necessary to add the StatusInfo=0 key.

An example of the displayed information if StatusIinfo=1 or no key:

Uptinme: 00:00:12, nenory: 423.0 MB

[ FS] Heal t h ok.

[FS]Ring cycles count: O

[FS] Total index in nenory size: 62.7 KB

[FS] Total recorders: 4, MenFile: -1, menFile total size: 16.0 MB, last franme skipped tinme: none,
WitingQueueSi ze: 1500, avg speed: 18.99 MB/ sec.

[FS] Total readers: O (cached franes: 0)

[FS] Total caneras: 4, internal VMDA detectors: 0, external VMDA detectors: 0. zone detectors: O.

[FS] Camera 1. Witing queue: 1 frames(0% of 1500), size: 0.00 MB(O ns). Streans(1l): 1, total VMDA detectors 0
(int: O, ext: 0), zone: 0. Grabber_|P_CAM queue size: O.

[FS] Canera 2. Witing queue: O franes(0% of 1500), size: 0.00 MB(O ns). Streans(1l): 2, total VMDA detectors O
(int: O, ext: 0), zone: 0. Grabber_I|P_CAM queue size: O.

[FS] Canera 3. Witing queue: O franes(0% of 1500), size: 0.00 MB(O ns). Streans(1l): 3, total VMDA detectors O
(int: 0O, ext: 0), zone: 0. G abber_|P_CAM queue size: O.

[FS] Canera 4. Witing queue: 0O franes(0% of 1500), size: 0.00 MB(O ns). Streans(1l): 4, total VMDA detectors O
(int: O, ext: 0), zone: 0. Grabber_|P_CAM queue size: O.

Total registered senders: 1

oj ect s:

Vi deoFrane: 38(max: 77 at '09-09-22 14:40:13.014")

Audi oFranme: O(max: 5 at '09-09-22 14:40:08.816")

Msg: 73(max: 130 at '09-09-22 14:40:06.733")
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Active[ 1]
SendVi deoFr ane(l ocal =1, conpressed=1) to ' TAG 5509.1': value: 0 (max 0), delay = 46 ns, 09-09-22 14:40:15.548
I nactive[0] (no new data for nmore than 15 seconds)

An example of the displayed information if StatusInfo=0:

Uptinme: 00:00:12, nenory: 427.0 MB

[ FS] Heal t h ok.

[FS]Ri ng cycles count: O

[FS] Total index in nenory size: 52.9 KB

[FS] Total recorders: 4, MenFile: -1, menFile total size: 16.0 MB, |last frame skipped tinme: none,
WitingQueueSi ze: 1500, avg speed: 7.42 MB/ sec.

[FS] Total readers: O (cached franes: 0).

Find more about registry keys in Registry keys reference guide.

Example.

The Time of log keeping (hours) is 720 hours (1 month) and the Maximum size (MB) is 100 MB.

One week later the size of log file is 100 MB. It starts being rewritten though the log is kept less than it was specified.

And if DebugZipDays has the value equal to the time period in days to keep logs, then logs are not rewritten — they are archived in the
*.gz format and are kept for so long as it was specified in DebugZipDays parameter.
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Extended setup of the distributed architecture

Extended setup of the distributed architecture is performed in the DNS section; it is intended to create reserve connections between
the Client and other cores (Servers) in case of loosing connection with the main core. Reserve connections are to be set up for each
Client individually.

To create a reserve connection between the Client and a core, do the following:

Stop the Axxon PSIM software if it was running.

Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility).

Select the DNS node in the tree on the left side of the utility dialog box (see The Settings panel of the DNS section).
Specify the core computer name and IP-address in the table.

Click OK.

nhwnNge
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Changing computer names and IP addresses in
the Axxon PSIM configuration database

The Distributed configuration node allows changing the computer name and/or IP address in the Axxon PSIM database.
To change the computer name in the configuration database, do the following:

1. Shut down Axxon PSIM if it runs.
2. Start the tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility).

3. Select the Distributed configuration in the tree on the left side of the utility dialog box (see The Settings panel of the
Distributed configuration section).

ns.

i [> Windows
= [ Awxon PSIM
[» DNS
D Vistor management system Select database Use cument DB
[> Distributed configuration :
Available systems:
- [> MSDE (M5 SQL) corfiguration it b
[> Video subsystem ] _I System identifier _Name
[» Testing video capture cards LOCALHOST LOCALHOST

[ Version

Mew system 1D
[LocALHOST

Update protocal 5
[ Clear pratocel B

| Update DB

OBJ_YITU_CLIENT..OK

OBJ_ZONE.. OK
UPDATE_PERSON_LOG..OK
OBJ_SLAVE..SET NAME LOCALHOST..OK
PROTOCOL..OK

wdate finished ==

Change IP address

g -~ > [1z7oor 10

% Axxon PSIM® Advanced Setup

As a result the Available systems (3) table will show all computer names registered in the selected database.

. To select the computer name to be changed in the Available systems table, right-click an appropriate row. The row will be
highlighted.

6. Click the button next to the New system ID (4) field to see the drop-down list of available computer names. Select the

Select the database containing the computer name to be changed using the Select database (1) or Use current DB (2) butto

required computer name in the list. The selected nhame will appear in the New system ID field. Name can also be entered in

the field manually.

ear protocol checkbox to delete all records in the log. Only one of two checkboxes should be set.
the Update DB button (8).
To change the IP address in the configuration database, do the following:

Do steps 1-4 of the previous instructions.

Select the IP address to be replaced from the drop-down list (9).
Enter a new IP address into the field (10).

Click the Edit button (11).

bl N S

The IP address in the database will be changed.
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Set one of the following checkboxes: Update Protocol (5) checkbox to replace the computer name in the events log, or the CI

Click the Update DB button (7). The progress of replacing computer names for a new one will be displayed in the field below



Limiting memory usage by an MS SQL server

A certain amount of disk space is allocated for the SQL server for storing its data, functions and other internal structures. Allocated
RAM is determined by default by the total RAM resources available for the SQL server in the system. The Tweaki.exe utility allows
limiting the amount of RAM allocated for the SQL server. Do the following:

1. Close the Axxon PSIM software if it is open.
2. Start the Tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility section).

[ Windows
[> Awxon PSIM
- [> DNS
- [» Visitor management system
- [» Distributed configuration
S b8 MSDE (M3 SQL) configuration
[ Video subsystem
[» Testing video capture cards
[ PTZ

% Axxon PSIME Advanced Setup

Select database 1 | or

Maximum memory usage (MB)

4096

3

SQL database size:

GB

3. Select the Configure MSDE (MS SQL) node in the tree on the left side of the utility dialog box (see The Settings panel of the

MSDE (MS SQL) configuration section).

4. Select the MS SQL database to limit the allocated RAM by doing one of the following using Select database (1) or Use

current DB (2) buttons.

6. Click the OK button (4).

68

In the Maximum memory usage (MB) (3) enter the required amount of memory to be allocated for the SQL server.



Re-indexing the audio and video recordings
archive

To re-index the audio and video archives, do the following:

1.
2.
3.

5.
6.

Close the Axxon PSIM software if it is open.

Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility).

Select the Video Subsystem node in the tree on the left side of the utility dialog box (see The Settings panel of the Video
subsystem section).

Click the Rebuild Index button to delete the INDEX folder with .idx files containing the indexes to the video recording files in
the archive.

(D Note.

Pressing the button Rebuild index sets the value of parameter IndexRebuilding=1 in the register’s branch of OS
Windows: HKLM\SOFTWARE\AxxonSoft\PSIM\VIDEO for 32-bit system
(HKLM\SOFTWARE\Wow6432Node\AxxonSoft\PSIM\VIDEO for 64-bit). Alterarchive reindexing the value of the
parameter IndexRebuilding=0 is automatically set. When Axxon PSIM software is run together with
IndexRebuilding=1 parameter, the archive is reindexed without any attempt to reas it from *.idx files.

Click OK.
Start the Axxon PSIM system again. A new INDEX folder will be created in the video archive folder, containing new indexes.

This completes re-indexing of the database.
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Enabling the Pure video/CUDA hardware
acceleration

It is possible to enable the PureVideo/CUDA hardware acceleration when video signals are decompressed from IP devices. In this case
decompression may be carried out by Server’s graphics processor and this reduces the load on CPU.

1 Attention!

It is recommended to update the driver of the card that supports the PureVideo/CUDA hardware acceleration. Drivers are
available for downloading at the official web page of NVIDIA (www.NVIDIA.com).

@ Note.

Detailed information about the PureVideo/CUDA hardware acceleration is given in reference manual of NVIDIA company.

The PureVideo/CUDA hardware acceleration functionality is implemented correctly when Server meets the following requirements of
the software platform:

1. Is managed by OS Windows XP/Vista/7.
2. The PureVideo HD video card of the second or third generation is installed (NVIDIA VP2 and VP3).

(D Note.

Widespread models of video cards that support the PureVideo/CUDA:

NVIDIA GeForce GTX 295;
NVIDIA GeForce GTX 285;
NVIDIA Quadro NVS 450;
NVIDIA GeForce 9800 GT;
NVIDIA Quadro NVS 420;
NVIDIA Quadro NVS 295.

ORISR

(D Note.

In the Axxon PSIM software package the PureVideo/CUDA hardware acceleration is applied only for video signals’
decompression in H264 codec.

G) Note.

If the resolution more than 1920x1088 is set in the camera, then the PureVideo/CUDA hardware acceleration is not used for v
ideo signals’ decompression.

To enable the PureVideo/CUDA hardware acceleration, do the following:

1. Shutdown the Axxon PSIM software package if it was run on the computer.

2. Run the Tweaki.exe utility (See the Starting and shutting-down the Tweaki.exe utility section).

3. Select the Video subsystem section in the tree in the upper left corner of the utility’s dialog box (see The Settings panel of
the Video subsystem section).

4. Set the Use PureVideo/CUDA hardware acceleration checkbox.

5. Click the OK button.

6. Go to the settings panel for the Camera object.

7. In the Decompressor drop-down list select the H264CudaVP2Decoder value.

8. Click the Apply button.

The PureVideo/CUDA hardware acceleration is now enabled.
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Testing video capture cards

To test a video capture card, test its channels using the Testing video capture cards module of the Tweaki.exe utility. Do the

following:
1. Shut down the Axxon PSIM software if it is started.
2. Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility section).
3. Select the Testing video capture cards node in the tree on the left side of the utility dialog box (see The Settings panel of
the Testing video capture cards section).
4. Press Test button.

The Board field will display the name of the video capture card, and the Channels state table will show the information about each
channel of the card (number and status). The confirmation of successful testing will be displayed to the right of the Channels state

table.
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The utility for collecting configuration data on
servers and RWS for the Technical Support
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The purpose of the Support.exe utility

The Support.exe utility is designed for collecting information about the configuration and operating status of the hardware, OS
Windows and the Axxon PSIM™ system. The utility generates an archive that can be used by AxxonSoft Technical Support Service for
troubleshooting purposes. In case of system malfunction or errors in the Axxon PSIM™ system, do the following:

1. Go to the AxxonSoft tech support server: https://support.axxonsoft.com/.
2. Register a new account on the tech support server or log in the registered account.
3. Create an issue for tech support. Attach an archive generated by Support.exe utility.

Information on the issue progress will be sent to the email specified at registration.

@ How to get technical support
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Starting and shutting-down the Support.exe utility

To run Support.exe utility, use one of the following methods:

1. From the Start menu of OS Windows: Start -> All programs -> Axxon PSIM -> System’s information gathering utility
2. From the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Tools\Support.exe

After running the Support.exe, the Support — Collecting info about system utility dialog box is displayed.

Support - Collecting info about system - >

This application can be used for collecting data about the system and about the installed AsxoconSoft software.
Click Collect to create support_[date]_[time].7z file. After that vou can send it to AxwonSoft technical
support group.

Collecting dump-iles for the |ast days
Collecting logfiles for the last days

Collect

Step Status

Step 1 : Receiving info about installed software

Step 2 : Receiving info about the version of installed modules

Step 3 : Receiving info about the system

Step 4 : Receiving info about the Direct subsystem

Step 5 : Receiving info about HOD

Step 6 : Receiving info about the key files

Step 7 : Getting information about the registry settings

Step & : Copying configuration files

Step 9 : Copying settings files

Step 10 : Copying files of scripts and dialogs

Step 11 : Copying log files

Step 12 : Receiving info about TCPAIP{UDP) ports in use

Step 13 : Receiving info about the types of installed CPU

Step 14 : Getting information about the archives on all disks

Step 15 : Receiving info about the installed hardware

Step 16 : Receiving info about the installed Guardant dengles

Step 17 : Creating an archive copy of the M5 SQL Server database
Step 18 : Creating the archive copy of the DB without the protocols
Step 15 : Removing old dump- and logfiles

Step 20 : Compressing files

RENDORRMRRARNRNRRMNRRRRRRQCE @

Step 21 : Removing temporary files

To close the Support.exe utility, click the Close button.

74



The Support interface description

Support.exe utility interface includes the following elements:

Short directions for using the Support.exe (1).

A group of settings for specifying data set collection time period (2).

Collect button to run the process of gathering information (3).

Filed of displaying the information (4).

Table to display and select steps of gathering information, it includes two columns - Step and Status. In the Step column, the
short characteristics of information gathering process step is displayed and the step can be cancelled before the information
gathering starts. In the Status column there is displayed process-bar and time, spent on information gathering (5).

nhwbe

+ Support - Collecting info about system — *

This application can be used for collecting data about the system and about the installed AsxoconSoft software.
Click Collect to create support_[date]_[time].7z file. After that vou can send it to AxaconSoft technical
support group.

1

2

3 “:_"IBHSE wait, data are being mllfzcte:l. 4
is process may take several minutes ...

Step Status
Step 1 : Receiving info about installed software QK il s)
Step 2 : Receiving info about the version of installed modules QK {11 s)
Step 3 : Receiving info about the system QK {Ds)
Step 4 : Receiving info about the Direct X subsystem OK[3s)
Step 5 : Receiving info about HOD QK {Zs)
Step & : Receiving info about the key files QK (=)
Step 7 Getting information about the reqistry settings QK {Ds)
Step & ; Copying configuration files OK{Ds)
Step 5 : Copying settings files QK il s)
Step 10 : Copying files of scripts and dialogs QK {ls)
Step 11 : Copying log files QK {Ds)
Step 12 : Receiving info about TCP/IP{UDF) ports in use OK {Ds)

: Receiving info about the types of installed CPLU :

Step 14 : Getting information about the archives on all disks 5
Step 15 : Receiving info about the installed hardware

Step 16 : Receiving info about the installed Guardant dongles

Step 17 : Creating an archive copy of the M5 SQL Server database

Step 18 : Creating the archive copy of the DB without the protocals

Step 15 : Removing old dump- and logiles

Step 20 : Compressing files

RRRKOKKRKIERNRRRRRRRER R R R

Step 21 : Removing temporary files

To close the Support.exe utility, click the Close button.
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Collecting information about videoservers and
remote workstations using the Support.exe utility

To collect the information using the Support.exe utility, do the following:

1. Start the utility.
2. If necessary set the dump and log files collection parameters:

a. In the Collect dump files for days field specify the number of days for which dump files are to be included into
the data set for technical support (1).
b. In the Collect log files for days field specify the number of days for which log files are to be collected into the

data set for technical support (2).

3. By default, all available system information is collected. If necessary, uncheck the boxes next to the information collection
steps that should be skipped (3). If unchecked, information is not collected at the corresponding step.
Some stages of information collection are mutually exclusive, for example, you cannot simultaneously select the Creating an
archive copy of the MS SQL Sever database and Creating the archive copy of the DB without the protocols
checkboxes.
Some steps cannot be excluded, including Compressing files and Removing temporary files.

4. Click the Collect button (4).
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The data collection process will start. Upon completion, the result of information gathering on each step is displayed in the Status colu
mn (5), while the information area will show the link to the newly generated file - support.7z (6).

5 Support - Collecting info about systern = et

This application can be used for collecting data about the system and about the installed AxxonSoft software.
Click Collect to create support_[date]_[time].7z file. After that vou can send it to AxwonSoft technical
support group.

Collecting dump-files for the last days 1
Collecting log4iles for the last days 2

Collect 4 Completed! Open folder with file support 19-08-2022 16-00-27.7z §

Step 3 Status 5
Step 1 : Receiving info about installed software OK (0s)
Step 2 : Receiving info about the version of installed modules QK {10 s)
Step 3 : Receiving info about the system QK (0rs)
Step 4 : Receiving info about the DirectX subsystem QK (3s)
Step 5 Receiving info about HDD OK{Zs)
Step & ; Receiving info about the key files QK {Bs)
Step 7 : Getting information about the registry settings QK (0 s)
Step 8 : Copying configuration files QK (D s)
Step 9 : Copying settings files OK (0s)
Step 10 : Copying files of scripts and dialogs QK {ls)
Step 11 : Copying log files QK (0rs)
Step 12 : Receiving info about TCP/IP{UDP) ports in use QK (0 s)
Step 13 : Receiving info about the types of installed CPL OK(5s)
Step 14 : Getting information about the archives on all disks QK {Bs)
Step 15 : Receiving info about the installed hardware QK (0 s)
Step 16 : Receiving info about the installed Guardant dongles Emor!
Step 17 : Creating an archive copy of the M5 50QL Server database OK (0s)
[1 Step 18 : Creating the archive copy of the DB without the protocols

Step 19 : Removing old dump- and logiles QK (0rs)
Step 20 : Compressing files QK {1s)
Step 21 : Removing temparary files OK (Ds)

Follow the Open Folder with Support.7z File link to view the archive (6).
The archive is saved in C:\Users\%current user name%)\Documents\Support\.
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The Fps.exe utility for productivity estimation
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The purpose of the Fps.exe utility

Productivity measurement fps.exe utility is used to estimate productivity of video processing.

Estimation is done in the following way:

1. Segmentation of the given video fragment for a set of frames in jpeg format.

(D Note.

If the video fragment is not set, the utility generates pattern set of frames. When necessary the utility may store the

created set for fames to the selected directory.

2. Compression and/or decompression of the created frame set.
Calculation of productivity parameters — number of processed fps with defined resolution and colour.

(D Note.

Compression is not available on the Cilent. Playback of a previously recorded video, or a video being received over the

network in real time, is available.
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Starting and shutting-down the Fps.exe utility

To start fps.exe, do one of the following procedures:

1. Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Tools, then FPS testing
utility.
The fps.exe utility is available from the Start menu with the following installation types of the Axxon PSIM software: Server,
Remote administrator workstation, Remote client.

2. Start the utility from the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Modules64\fps.exe.

After starting the fps.exe utility there will be a dialog window Video processing FPS tester.

H Videoprocessing FPS tester = >

Video source; C:\WIDEOY3-08-22 1315, _01

[ Compression Check Skt
[ Decompression Chedk [~ Copy for stream
Codec |.-5.s in source file j
Mumber of channels per core lli Mumber of CPU cores in use m Quality m
JPEG images storage folder | J

Statistics

To close fps.exe utility click EI in the right upper corner of the utility’s dialog window.
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Using the Fps.exe utility

On the page:

® Selecting the video source
® Setting the check parameters
® Running the check and reading into its results

To check productivity of video processing, do the following:

Start the fps.exe utility (see Starting and shutting-down the Fps.exe utility).
Select the video source.

Set the check parameters.

Run the check and read into its results.

PN

Selecting the video source

The video source can be either an archive file or a video server archive recorded on specific cameras.

(D Note.

The field Video Source File is not required to run the check on an emulated pattern set of frames.

If the video source is an archive file, select it as follows:

1. Click File and then double click the required file in the Windows standard Open box (1).

H

Video source! 127.0.0.1, 1, Camera 1 2 File

Server

2. The full name of the selected file is displayed in the Video source field (2).

If the video source is a video server archive, make sure the Axxon PSIM is running on that server and all the required cameras are
created in the hardware tree before performing the check.

Select the archive video source as follows:
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1. Click Server (1). The Cameras dialog box opens.

H

Video source: 127.0.0.1, 1, Camera 1 ? File

1 Server

Cameras
IPaddess: | 127.0.0.1 Get Start

Cameras: 8 I selectall

e T
MNumbg 4

~Statisticy

T K

[ oK Cancel

In the IP field, specify the IP address of the Axxon PSIM video server (2).

Click Get (3). If connection with the server is established, the Cameras field displays the list of cameras.

4. Set the check boxes next to the cameras to check performance using their archive (4) or set the Select all check box to select
all the cameras in the list (5).

5. Click OK (6).

6. The selected cameras are added into the Video source field (7).

wn

Setting the check parameters
Set the parameters of performance check as follows:

1. Activate Compression check checkbox to check how many fps the given computer can compress (1).

1~ Compression Check Start

2% I copy for stream 3

Codec |As in source fle ~| 4 6 Stop

5 Mumber of channels per core | 1 Mumber of CPU cores in use |4 ? Quality |Med -

JPEG images storage folder ] 8 J

2. Activate Decompression check checkbox to check how many fps the given computer can decompress(2).

3. Select the Copy for stream check box to create a separate copy of each stream file in the RAM in order to avoid conflicts
during the check (3). This function increases memory consumption when running the fps.exe utility.

4. Select the required compressor version from the drop-down list Codec (4).

5. Enter the required number of emulated cameras in the field Channels amount (5).

(D Note.

This setting is actual only with emulation of pattern set of channels.

In the Number of CPU cores in use field specify the number of CPU cores to be used for performance check (6).
Select the required value of frames compression from the dropdown list Quality (inversely to compression level) (7).

No

8. When necessary, set the directory where frames extracted from the video would be unzipped by clicking next to the
Jpeg images storage folder field (8).

Running the check and reading into its results

Click the Start button to run video processing tester (1).
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H Videoprocessing FPS tester =

>
Video source: C:\WIDEO\03-08-22 134, 01 Fil

| s 1
Codec |.f-.s in source file _]
Mumber of channels per core ]1—‘ Mumber of CPU cores in use m Quality {Med "
JPEG images storage folder I J

-Statistics

[2022-08-19 11:59:55]

CPU: using 4 CPU cores from 4
Compressors & decompressors per thread: 1 2

Compression: 739 fps [ ~ live channels: 29 )

Decompression: 96 fps { ~ live channels: 3, decompress time max: 62 ms, avg: 2ms )
Ratio: 121,994

Version: MPEG4 (56)

Width x Height: 1792 x 984

Color: color

As a result, parameters of video processing productivity will be displayed in the title bar of the utility window (2).

Productivity parameter Description of parameter
Compression total number of frames that can be compressed in one second
Decompression total number of frames that can be decompressed in one second
Ratio compression ratio
Version selected version of the compressor
Width frame width
Height frame height
Color if the frame is in color
CPU number of CPU cores in use

Compressors $ decompressors per thread number of compressor instances per CPU

If the Jpeg images storage folder is selected, the frames for testing video processing will be recorded to the selected .jpeg files
storage folder.

The example of the emulated frame is shown below:
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To stop the testing process, click the Stop button (3).
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The ddi.exe utility for editing database templates
and external settings files

The ddi.exe utility is designed for editing external system settings files (*.ddi) and the templates of the main database (psim.dbi and
psim.ext.dbi).

The ddi.exe utility is started from the Start -> All Programs -> Axxon PSIM -> Tools -> System configuration menu.

The ddi.exe utility is available from the Start menu with the following installation types of Axxon PSIM: Server, Remote administrator
workstation, Remote client.

The utility can also be started from the Tools folder of the Axxon PSIM program folder.

After the changes are made to *.ddi and/or *.dbi files, update the main database. For this use the idb.exe utility (see The idb.exe
utility for converting databases, selecting database templates and making backup copies of databases section).

@ Note.

If changes were made to .ddi or .dbi files using the ddi.exe utility and these files were installed along with Axxon PSIM, then
these files will be deleted while deleting with configuration upload. .ddi and .dbi files added manually will be saved.
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Editing psim.dbi and psim.ext.dbi database
templates using the ddi.exe utility

To edit the template of the main database, open it using the File -> Open menu. The template files are stored in the root of the Axxon
PSIM program folder.

(D Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the Names tab.

(D Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other dbi files, to the
open dbi file.

Psim.dbi file contains the list of main tables and fields of the database. User-defined tables and fields are stored in a separate file -
psim.ext.dbi. This file is made separate from the main file, to eliminate the need to re-insert user-defined tables and fields into the
main file, in case of Axxon PSIM system update. The contents of these files are merged upon Axxon PSIM start-up.

To view the database template, open the DBI tab in the top left corner of the window. The list of the tables of the main Axxon PSIM
database will be displayed in the left panel. The right panel will show the list of fields of the selected database.

@ DDI & DBI Editor - [C:\Pregram Files (x88)\A&xcon PSIMYpsim.dbi] — O s
File

(a]n]] DBI Field name Type Size Description

FOLDERS

FOLDERS_OBJS action CHAR T |32

E&;ﬂER params TEXT -

MARKERS description CHAR - |70

OBJPARAM

OBJTYPE type CHAR - |5

OBJ_ACTIVEX

OBJ_ACTIVEX1 . -

OBJ_ARCH

OBJ_ARCHPANEL
0OBJ_ARCH_CAM

OBJ_ATM

OBJ_ATMI
OBJ_ATMI_CAMS
OBJ_ATMI_COLOR_WORDS
OBJ_ATMI_EVENT_WORDS
OBJ_ATMX25_CLIENT
OBJ_ATMX25_CLIENT_OBJS
OBJ_ATMX25_SERVER

OBJ_ATMX25_SERVER_OBJS

OBJ_ATM_ITV

OBJ_CAM [EVENT]
OBJ_CAM_AUDIO objtype, CHAR, 255
OBJ_CAM_FACECAPTURE action, CHAR, 32
OBJ_CAM_IP_DETECTOR params, TEXT
QBJ_CAM_TITLE description, CHAR, 70
OBJ_CAM_TITLE_COLOR_WORDS type, CHAR, 5

OBJ_CAM_ECHD

OBJ_CAM_VMDA

OBJ_CAM_VMDA_PERSP

OBJ_CAM_VMDA_DETECTOR
OBJ_CAM_VMDA_DETECTOR2
OBJ_CAM_ZONE
OBJ_VIDEOSTREAM
OBJ_CARFLOW

OBJ_CONFIG
OBJ_CONTROLLER

0 R

=
11

OBJ_DEMO v

Total objects: 180

To delete, add, edit or copy object fields, use the table on the left of the utility box.
The following parameters of the table fields are displayed:

1. Field name - the name of the field in the database.
2. Type - data type of the field contents. Available types:
a. BIT - checkboxes taking logical values Yes and No;
b. CHAR - fields with a few symbols;
c. DATETIME - date and time in the following format: date - dd-mm-yyyy, time — hh:mm:ss;
d. DOUBLE, INTEGER, SMALLINT - numerical fields of corresponding types;
e. TEXT - fields with the text.
3. Size - maximum number of units of the specified format in a field.
4. Description - field name shown in the interface.
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The database is to be refreshed after the changes were made.
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Editing the external setting file (Axxon PSIM.ddi)
using the ddi.exe utility

To edit the external settings file (psim.ddi), open it using the File -> Open menu. This file is stored in the root of the Axxon PSIM
program folder.

(D Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the Names tab.

(D Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other dbi files, to the
open dbi file.

The external settings file contains the information about objects and events loaded into the system configuration, graphical symbols for
various object states on the map, and the transition rules from one object state to another.

The purpose of editing can be software localization or expanding/limiting its functionality (for example, removing unused objects from
the system).

@ Note.

Changing the external settings file may lead to system failure. Create a backup copy of the file before editing it.

The database is to be refreshed after the changes were made.
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General information on editing the external
setting file

To start using the utility, open the DDI tab in the top left corner of the utility dialog box.

The left side of the dialog box will display all system objects loaded into the configuration. The right side of the dialog box shows the
properties panel for the selected object. This panel consists of several tabs: Names, Events, Reactions, Icons, States, and Transiti

on rules.

To delete, add, edit or copy object properties, right-click a cell in the tab or the list of system objects to open the context menu. You
can also use Ctrl+C and Ctrl+V to copy and paste lines from one object to another. Select the whole line(s) or just a cell(s) in it to
copy by Ctrl+C. Delete lines with Delete key.

To edit the object properties, use the tables on the right of the ddi.exe utility box.
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The Names tab

This tab contains the table with three fields:

[y

Object - object ID in the system.

Name - the name of the object in the system.

3. Group name - the name of the group the object will be assigned to upon creation. If this field is left blank, no group will be
created. Objects of different types may be assigned to the same group given that they have the same parent object (e.g., Sens
or and Relay can be included to the "Sensors and Relays" group and so on).

N

By default all objects, the description of which the ddi file contain, are displayed in the table. To find an object, type-in the object
name or ID in the Search by name field. As a result the table will contain all object names in the system that exactly or partially
match the word typed in this field.

@ DDI & DBl Editor - [C:\Program Files (x86)\Accon PSIM\Languages\en\psim.ddi] = - O X
File

DDl DBl Names Everts Reactions lcons States Transfernies

ACTIVEX

ARCH Search by name

ARCHPAMEL |gra|

ATM

ATMX25_CLIENT

ATM325 SERVER Object Name Group name

ATM_ITV » GRABBER Video capture device

EimfFACECAPTURE GRAY Sensor Sensors

CAM_IP_DETECTOR

Cam_TITLE PROGRAM Program Programs

CAM_ECHD FIXML_SERVER 15D integration server

CAM_VMDA

CAM_VMDA_DETECTOR PROGRAM_STREAMING_SERVER PS-RTP Server

A YITU_CLIENT YITU irtegration ciert

CONFIG INTEGRATION_HTTP_CLIENT

DEPARTMENT

DIALOG

DISPLAY

DMD

EVENT_COUNTER
EVENT_VIEWER

MAIL_MESSAGE
MAIN

MAP
MAPLAYER
MAPPLATFORM
MESSAGE

MMS
MONITOR i
Total objects: 89
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The Events tab

This tab contains the list of the system events that the selected object can create. Each event has the following editable parameters:

nhwbe

when the event occurs.

o

database.

Name. The event identifier.

Description. A short description of the event.
Processing messages. The type of window to open on event occurrence: alarm window or information window.
Support audio. The attached .wav files to be played when the event occurs.
Disable network connection. A local event only. If this checkbox is set, other computers on the network will not be notified

Disable logging. By default, all events are displayed in the Event log. Set the checkbox not to log the event or record it in the

7. Windows log. Set the checkbox to log the event (see step 6) to Windows log. If the event is not logged, then it cannot be

logged to Windows log.

File

@ DDI & DBl Editor - [C:\Program Files (x8)\Axxon PSIM\Languagesien)psim.ddi] *

Names | Everts | Reactions lcons States Transfernes

ARCHPANEL
ATM

ATMX25_CLIENT
ATMX25_SERVER
ATM_ITV

CAM
CAM_FACECAPTURE
CAM_IP_DETECTOR
CAM_TITLE

CAM_ECHD

CAM_VMDA
CAM_VMDA_DETECTOR
CAM_VMDA_DETECTOR2
CAM _ZONE

CONFIG

DEPARTMENT

DIALOG

DISPLAY

DMD

DRS

EVENT_COUNTER
EVENT_VIEWER

GATE
GRAY
GRELE
HTTP
KEYB
LEVEL

LMCFTP
LMCGATE

MACRO
MAIL_MESSAGE
MAIN

MAP

MAPLAYER
MAPPLATFORM
MESSAGE

MM3

MONITOR

Processing
messages

» 5 - AC power suppl... |INFORMATION

Name Description

Parameters for event "UPS - AC power supply restored™:

Support audio

Disable network

connection

Digable logging

Windows log

| Parameter Name

Type

| Elemert

Value

Total objects: 89

{D Note

You can create only the events that are available for the selected object (created at the stage of the system programming).
Initially all of them are in the psim.ddi file.
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The Reactions tab

This tab lists all reactions that the object can make in response to events. Each reaction has the following properties:

1. Reaction - reaction ID.
2. Description - short description of the reaction.
3. Arming - additional property of the reaction, arming a region.

@ DDl & DBl Editor - [C:\Program Files (x86)\Awcon PSIM\Languagesen\psim.ddi] * - O
File

DDl DBl Names Everts Reactions lcons States Transfernies

QEEHEX ~ Reaction Description Arming region
ARCHPANEL 4
ATM

ATMX25_CLIENT
ATMXZ5_SERVER CONFIRM Classffy alam

ATM_ITV
CAM .

] O el

CAM_FACECAPTURE
CAM_IP_DETECTOR
CAM_TITLE

CAM_ECHD

CAM_VMDA
CAM_VMDA_DETECTOR
CAM_VMDA_DETECTOR2
CAM_ZONE

CONFIG

DEPARTMENT

DIALOG

DISFLAY

DMD

DRS

EVENT COUNTER
EVENT_VIEWER

GATE

GRELE Parameters of action "Arm":

KEYE Parameter Name Type Element Value

MACRO
MAIL_MESSAGE
MAIN

MAP

MAPLAYER

MAPPLATFORM
MESSAGE

MMS
MONITOR b

Total chjects: 89

(D Note.

You can create only the reactions that are available for the selected object (created at the stage of system programming).
Initially all of them are in the psim.ddi file.
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The Icons tab

This tab lists the graphical symbols (icons) that represent the selected object on the map. The part of the name used for identifying
the file in the .bmp, .jpg or .png format is specified in the File name column. Image files are to be stored in the Bmp folder in the Axx
on PSIM program folder (for example, C:\ Program Files\Axxon PSIM\Bmp).

@ DDI & DBI Editor - [C:\Program Files (x86)\Axxon PSIM\Languages\en\psim.ddi] © - m] *

File
Dol DBl Names

Events Reactions || States  Transfer ules

ACTIVEX ~
ARCH

ARCHPANEL 3
ATMX25_CLIENT

ATMX25_SERVER
ATM_ITV

CAM
CAM_FACECAPTURE
CAM_IP_DETECTOR
CAM_TITLE

CAMECHD

CAMZVMDA
CAM_VMDA_DETECTOR
CAM_VMDA_DETECTOR2 .
CAM_ZONE
CONFIG
DEPARTMENT
DIALOG
DISPLAY

DMD

EVENT_COUNTER
EVENT_VIEWER

GATE

GRABBER

MAIL_MESSAGE
MAIN
MAP

MAPLAYER
MAPPLATFORM
MESSAGE

MM3
MONITOR e

File name

zone_smoke

Name

Smoke

zome_ir

Infrared

zone_smik

Reed switch

zone_window

Window

zone_glass

Glass

zone_pir

FIR

Total objects: 89

If default icons are to be in use for the same states of objects of the same type, the def icon should be specified on this tab (By

default). See The States tab section for more information.

File
DDl DBl

@ DDI & DB Editor - [C:\Program Files (x86)\Axxon PSIM\Languages\en'\psim.ddi] *

Mames Everts Reactions lcons  States  Transfernles

ARCH

ARCHFANEL

ATM
ATMX25_CLIENT
ATMX25_SERVER
ATM_ITV

CAM
CAM_FACECAPTURE
CAM_IP_DETECTCOR
CAM_TITLE

CAM_ECHD
FAM MNL

ACTIVEX A

File name

MName

cam

Standard

camptz

FTZ

camfisheye
s def

Fisheye

By default
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The States tab

This tab lists all states of the selected object. The states have the following properties:

1. Name - state ID.

2. Image - part of the name in the .bmp format that represent the object state on the map. For example, if the zone_fire file
name was selected in the Icons tab, and the image of the selected ARMED state is arm, then the zone_fire_arm.bmp file will
be in the Bmp folder.

The default icon for the states can be set. For this, set the def icon (By default) on the Icons tab. For example, if there is no

zone_fire_arm.bmp icon for the ARMED state, then the def_arm.bmp icon will be searched. This avoids duplicating icons if one state
for the different types of the object icon should be displayed identically.

(D Note.

If the file ID is not set in the Icons tab, then the file name will consist of the object ID and part of the file name specified in
the Image column.

@ Note.

If the object is displayed on the map as a polygon, circle or line, then the color of these figures can be set for each state.

For this specify the color in the R:G:B:A format after the icon name (separated by $) in the Image column or specify the
color only in this format instead of the icon name. Here are the examples of the Image column contents:

255:0:0 - red color is set for the state.

alarm$255:0:0 - icon and red color are set for the state.

1. Description - short description of the state.
2. Blinking on alarm - option of displaying object state.

@ DDI & DBl Editor - [C:\Program Files (x868)\Axxon PSIM\Languagesien\psim.ddi] * - O X
File

DDl DBl Names Events Reactions lcons |Siates | Transfermies

igg:Ex -~ Name Image Description Blinking on alam

ARCHPANEL (3 ARMED am | Armed | [ ]

e | DISARMED disam Disamed O

ATMX25_SERVER ALARMED alam Alzm

ATM_ITV

CAM CONFIRMED nom AMam accepted (]

Egu:r;fDEé?&TTUORRE DETACHED_DISARM detach Connection lost

CAM_TITLE | i

CAM_ECHD OFF attention Nomal(off) O

CAM_VMDA |ON nom Activelon) O

CAM_VMDA_DETECTOR

CAM_VMDA_DETECTOR2 b 0

CAM_ZONE

CONFIG

DEPARTMENT

DIALOG

DISPLAY

DMD

DRS

EVENT_COUNTER
EVENT_VIEWER

LMCGATE
MACRO
MAIL_MESSAGE
MAIN

MAP

MAPLAYER

MAPPLATFORM
MESSAGE

MMS
MONITOR b
Total objects: 89
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The Transition rules tab

Transition rules connect the events generated by objects, and the states of these objects. Each rule consists of the starting state of the
object, an event, and an ending state that the object will take after the event.

The table lists the transition rules from one object state to another. Each rule has the following properties:

1. Event - identifier of the event triggering the transition.

2. Transition from state - identifier of the object state before the event took place. If this field is left blank, the rule will apply
to all starting states.

3. Transition to state - identifier of the resultant state of the object.

@ DDI & DBI Editor - [C:\Program Files (x86)\Axxon PSIM\Languages\en\psim.ddi] © — m] *
File

DDl DBl Names Events Reactions lcons States | Transferrules

ACTIVEX ~ Event Move from state Move to state

ARCH "

ARCHPANEL »

ATM

ATMX25_CLIENT OFF = - |OFF s

ATMX25_SERVER SIGNAL_LOST = |oN ~ | DETACHED_ON -

ATM_ITV

CAM SIGNAL_LOST * |OFF ~ | DETACHED_OFF =

CAM_FACECAPTURE T

CAM_IP_DETECTOR . - = i

CAM_TITLE

CAM_ECHD

CAM_VMDA

CAM_VMDA_DETECTOR
CAM_VMDA_DETECTOR2
CAM_ZONE

CONFIG

DEPARTMENT

DIALOG

DISPLAY

DMD

EVENT_COUNTER
EVENT_VIEWER

GATE
GRABBER
GRAY

IGRELE ]
HTTP

KEYB

LEVEL

LMCFTP
LMCGATE
MACRO
MAIL_MESSAGE
MAIN

MAP
MAPLAYER

MAPPLATFORM
MESSAGE

MM3
MONITOR i
Total objects: 89
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Example of editing the Axxon PSIM.ddi file to
reduce database load

When changing the ddi file events, reactions, etc. can be added, modified or deleted.
To reduce database load modify the psim.ddi file as follows:

1.
2.

5.
6.

Open the psim.ddi file in the ddi.exe utility.
Select the CAM object.

@ DDI & DBI Editor - [C:\Program Files (x86)\Axxon PSIM\Languageshentpsim.ddil - o x
File
DDl DB Names {EVenis| Reactions Icons States Transfer uies
ACTIVEX n
SRCH 2 Name Descrption ,:’:;Z?;”f Suppot audio Usablenetwok  Disabie logong Windaws log &
ARCHPANEL
Sl o_sTaRT | Aam L
ATHX25_CLIENT
ATMX25SERVER D_STOP Aam end [m] ]
Lot i 0 = L =
CAM_FACECAPTURE DETACH Connection lost [} [m] O O
CAM_IP_DETECTOR
CAM_TITLE u u L} L}
CAM_ECHD -
CAM_VMDA I 5 - - -
CAM_VMDA_DETECTOR REC Harddisk rec O O O O
CAM_VMDA_DETECTOR2
CAM_ZONE PRINT Print frame [m] O O O
CONFIG
DEPARTMENT
DIALOG UNBLINDING End of blinding a O O O
DISPLAY
DND REC_STOP Record on disk siopped 0 O O O
DRS 5 ]
EVENT COUNTER RECORDER_ON Record on [m] ] ] ]
g\/A%ET_wEWER RECORDER_OFF Record off O O O O
GRARRFR DISC MOLNT Disk mourted m r r r v

Go to the Events tab.

Set the Disable network connection and Disable logging checkboxes checked for the MD_START (Alarm) and MD_STOP
(Alarm end) events.

Save the file.

Update the database using the idb.exe utility (the Update database button, see Interface elements of the idb.exe window).

When these actions are performed the events from the main motion detection tool are not recorded and sent to other cores. This
reduces the database load.

Important!

When updating Axxon PSIM the modified psim.ddi file is substituted with the file by default.

In order the psim.ddi file is not substituted it is to be saved with another name at step 5 - e.g. "psim_1.ddi". Thus, 2 files of external
settings are saved in the Languages catalog: source file and modified one. The idb.exe utility loads them in alphabetical order. As a
result the psim_1.ddi file is loaded the last one and its parameters are applied when database is updated.

If the event list in psim_1.ddi is different from the original psim.ddi, e.g. some events are added or deleted, then the event list is
merged by idb.exe DB update.

When installing a new Axxon PSIM version the psim_1.ddi file is not affected by the installation wizard and changes are saved.

Important!

When deleting Axxon PSIM without saving the configuration the entire Axxon PSIM catalog (including modified files) is
deleted. In this case the modified files are to be manually backed up, e.g. to C:\Temp, under after reinstallation they are to
be copied to <Axxon PSIM installation folder>\Languages\en.
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The Arpedit.exe utility for creating user dialog
windows

The Arpedit.exe utility is designed for creating dialog boxes. It allows tailoring Axxon PSIM system to particular monitoring and security
tasks of the customer.

The Arpedit.exe utility is in the “Arpedit” folder (<Installation directory>\Axxon PSIM\Tools\Arpedit). Detailed information on the utility
is given in User's Manual for ArpEdit (it is located in pdf format in the same folder too).
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User's Manual for ArpEdit
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Introduction into User's Manual for ArpEdit

On the page:

® The purpose of the document
® The purpose of ArpEdit

The purpose of the document

The User’s Manual for ArpEdit is a reference tool and contains information needed to work with the ArpEdit. This utility is included in
the basic distribution of the Axxon PSIM software package.

The following materials are included in this manual:

1. General information on ArpEdit.
2. User guidelines for ArpEdit.

The purpose of ArpEdit

ArpEdit is designed to perform the following functions:

1. Creating badge forms for the Access Control Service module (in the form of files with the .arp extension).
2. Creating user dialog boxes (in the form of files with the .dlg extension).

(D Note.

The dialog box is connected to Axxon PSIM via a system operator object query window and displayed as a result of the
macro commands that are specifically designed to work with this dialog box. Thus, the ArpEdit utility allows you to completely
adapt Axxon PSIM to solve particular problems of control and security at a production facility.
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General principles of operating ArpEdit

100



Starting and shutting down ArpEdit

Launching ArpEdit can be done in one of the following ways:

1. Launch from the Axxon PSIM installation directory. To launch the ArpEdit utility from the Axxon PSIM installation directory,
follow these steps:
a. Go to the folder where you installed Axxon PSIM (default directory is C:\Program files\Axxon PSIM).
b. Go to the Tools\Arpedit folder.
c. Launch the file arpedit.exe.
2. Launch from the Start menu. To launch the ArpEdit utility from the Start menu, select the menu item Create dialog
windows, located in Start Axxon PSIM.

i Hoocon PSIM

S Additional Utilities for the PSIM soft...

S Administrator's guide

% Advanced settings utility

#7 Aucon player

[:,':J Moocon PSIM

C’ AaxonSoft EXPERT

S Brief operator's guide
% Check digital signature
1%, Collect system's data

Tt
S Configuring security components gu..

Create dialog windows

Closing the operation of the ArpEdit utility may be done in one of the following ways:

1. In the system menu of the ArpEdit utility, in the File heading, select Exit.

ditor v1.1

File Edit View
MNew... Ctrl+M
Open... Ctrl+ O
Save Ctrl+5

Save As..,

Grid's Print

.

1 arp1.ARP

Exit
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2. Click E

If the document contains any unsaved changes, a Report editor dialog box appears.

Report's editor ' x|

L] E Save changes to Untitled?
[

Yes Mo | Zancel |

To confirm the changes, click Yes. To exit the program without saving the changes, click No.

The utility window will close.
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Description of the interface elements of the
ArpEdit utility

The ArpEdit utility window contains the following key interface elements:

(D Note.

More information on the interface elements of the ArpEdit utility can be found in the appendix (see APPENDIX 1. Interface
elements of the ArpEdit utility).

1. The System menu. Provides access to file operations, editing functions and window display settings for the ArpEdit utility (1).
- arp1.ARP - ARP Editor v1.1

File Edit View 1
bl 0o B & 7 o= Ae ab — | [ B0 E N Y AL m 123 2
3
Ready NUM 4
2. Toolbar. Provides access to key features of the utility (2).

3. Workspace. Contains elements of the badge or dialog box, add users, and allows for the management of placement and sizes (3
).

4. The status bar displays information about the actions produced by the utility (4).

103



Creating ArpEdit objects

ArpEdit objects are divided into the user interface and variable elements. To create a new object in the workspace, follow these steps:

1. Select a section of the workspace where you want to add an item, click on it. The selected part will be highlighted in blue.
T+ arp1.ARP - ARP Editor v1.1

File Edit View
el Oo H D A A ab — | OO W E N 2 4L M 123

2. Go to the ArpEdit toolbar.
e OO H @ A [z a0 — | O N AP Mmoo

3. Select the object to be added by clicking the left mouse button on the appropriate icon on the toolbar (see description below).
4. Click the left mouse button at the point in the workspace in which to place the upper left corner of the object.

(D Note.

The dimensions of the created object can be changed in two ways:

1. By dragging the right or bottom edge of the object with the mouse.
2. By setting new values for the height and width of the object in the field box (see Setting field variables).

The position of the created object can also be modified in two ways:

1. Dragging the object with the mouse from the top or left edge.
2. By setting the new position of the object in the field variable window (see Setting field variables).

ArpEdit objects:

[ |

Name Description Purpose

Text Fixed text field Display fixed text field

]

Name Description Purpose
Variable Variable text field, hidden text box, button or drop-down
list 1. Displays information from the database when creating

badges
2. Variable when creating dialog boxes

=l BN AN

Name Description Purpose

Line A line of given length and direction = Design element

g
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Name Description Purpose

Frame Set rectangular frame sizes Design element

L

Name Description Purpose

Square Set filled square sizes = Design element

Name Description Purpose

Image Image placed at a specific location = Insert client photographs in the badge form for printing

Creating a new object is finished.
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Setting object display variables
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Setting field variables

To set the field variables, follow these steps:

1. In order to set the field variables, it is necessary to select the variables of the object in the workspace, and open the Variables
field in one the following ways:

o 2
a. Click on the toolbar;

b. In the object functional menu, select Properties.

(D Note.

The object functional menu is opened by right-clicking anywhere inside the object.

Properties
Font...
Color...

Background color

Remove
Copy
Paste

2. The Field variables window will appear.

Fildsoptions

Alignrment
% Standard
£ Left 3
i Right

i Centered

ine'z thickness

g
G

Tem
* Equal to zemo ™ Mare than zero
i~ ME to zemo

1§ Lezs than zeno

Field.. | (o D cenes |

3. In the text field (1) enter information describing the field:
a. Enter text in Text field, which will be displayed in the text field.
b. For Variable, enter the variable name.
c. For an Image, enter the image address in quotes. The image must be placed in one of the following folders:
i. In the Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon PSIM), then in the field (1) enter
the image name, e.g. “image.bmp”.
ii. In the Bmp folder of the Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon PSIM\Bmp), then
enter the image file address as "Bmp\image.bmp" or "Bmp/image.bmp".

4. If you would like to fill in the text field with data from a text file or enter a large amount of data, then click the —I button (2
) and use a text editor (see the section in APPENDIX 2. Entering text using the editor).

5. Set the Alignment settings for the desired justification of the text within a selected object (3).

6. Select units of measure which will be used to size the object:
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a. If the size of the object will be given in millimeters, then check the in mm box (5).
b. If the size of the object will be given in characters [symbols], then check the Width in symbols box (9).

@ Note.

The size of the object is given in characters [symbols] by default.

7. Set the position of the upper left of the object in one of the following ways:
a. Specify the absolute coordinates of the object. In this case you should indicate the position of the upper left corner by
setting the X-axis in the X field, and the Y-axis in the Y field: (6)
b. Specify the relative coordinates of the object. In this case you should check the Relative box (4).
8. The width and height of the object can be set in one of the following ways:
a. Specify the width of the object in the W field, and the height of object in the H field (7).
b. Specify the coordinates of the lower-right corner. To do this, check the X2, Y2 box (8). The W and H fields will be by X
2 and Y2. After this, specify the coordinates of the lower-right corner of the object using the X2 field for the x-axis and
the Y2 field for the y-axis.

x
| ]

— Coordinates — Alignment
[ Relative ™ in & Standard
w3 v o " Left

; "™y | " Right

Gz o vz[o | g
™ w2v2 [ Widthinspmbols | | © Centered
Line's thickness IEI [” Hidden

[T Group

— Term
¥ Equal to zero " More than zemo
" ME ta zero " Less than zemo

Fisld. | [ o

9. Specify the line thickness in the Line thickness field in the desired units (10).
10. If a custom object should be on the badge or there is a dialog window, but it should not be visible to the user, then check the H
idden box (11).
11. If the object must be part of a group, check the Group box (12).
12. Click OK (13).

Cancel

Setting the variables is completed.
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Setting the text font

To set the text font, follow these steps:
1. Select Font from the menu.
Properties
Font...
Color...

Background color

Remove
Copy
Paste

2. Using the standard font selection menu, set the text display settings.

Fant: Fant ztyle: Size:
IHegular | ] 4 I

(} @dnial Unicode M5 . a -

H @Batang [talic 9 Lancel |
H @B atangChe Eald 10

H @Daotum Bold Italic 11

% @0 atumChe 12

EGELlim 14

T @GulimChe I 16 =l
— Effects — Sample

[T Stikeout

[T Underline

Calor:

I- Black j Scripk:

Setting the text font is completed.
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Setting the color

To set the color, follow these steps:
1. Select Color from the menu.
Properties
Font...
Color...

Background color

2. Using the standard color selection menu, select the color desired for the object

rl:l lor

EEEENT
THERNT

Huucl_ Ftad]_
Satl_ Green: [0

Diefire Custom Colors > | Color3olid Lu'n:l_ BMB:]_
ok | Cconcel | Add to Custom Colors |

Setting the color of the object is completed.
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Setting the background color of the object

To set the background color of the object, follow these steps:
1. Select Background color from the menu.
Properties
Font...
Color...

Background color

Remove

Copy
Paste
2. Using the standard color selection menu, select the background color desired for the object.
Cnlﬂr
Baw:auhx
Il [
Ul
Iy
HTFENENE
HEEEN

Hue[160  Red ]_

Sat[0  Green|0
[Defiree Custom Colors >» | Eﬂhﬁﬁd L I_ Bluee: |0 l_

ok | Cconcel | Add to Custom Colors |

Setting the background color of the object is completed.
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Creating dialog boxes
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Creating a dialog box form

In the Axxon PSIM dialog box, objects will be displayed in the ArpEdit workspace.
Create a dialog box form in the following order:
1. Create design elements in the workspace.

2. Create variables in the workspace.
3. Configure the design elements in the workspace.
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Create design elements

The design element types in the dialog box correspond to their appearance on the workspace. You can add the following design
elements to the dialog box form:

||
1. Square. Adding a square in the workspace is done by clicking on the —| on the ArpEdit toolbar (1).

H[F B[] aefan|—| 1| ofm|@m|N] %] 4 ,@|,<3>||E|u..3.”

ol [T ol f =)
2

bkt
tet field 5 [ editable texthie

3

‘ on-editable bext field rion-editabl

list vl

7

| p—
4

E :closi

=l N
2. Line. Adding a line in the workspace is done using one of the following buttons: —I on the ArpEdit toolbar (2).

Az
3. Text field. Adding a text field in the workspace is done by clicking on the —I on the ArpEdit toolbar (3).

(I
4. Frame. Adding a frame in the workspace is done by clicking on the —| on the ArpEdit toolbar (4).

Creating design elements is completed.
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Creating variables

ab
Creating variables in the workspace is done using the —| on the ArpEdit toolbar. Depending on the variable setting they may be
displayed in the dialog box as follows:

1. Editable text field (1). Additional configuration after adding is not needed (5).

C_ bion 2

noh-editable texst figld

“ G

cloze |

2. Button (2). In order to display a variable as a button in the dialog box, you must configure it after adding it to the workspace,
as follows (6):

|
a. Click —| on the toolbar. The Field options window will open.

x
et 1Colose D Nareedi I~ Hidden

Drefault alue [ Prey valus [~ Autooain
Calculation formula 2 €' DIALOG 71" 1'CLOSE | pH
¥ Sting " Inkegral |' b onetary unit
= Date {" Beal [ Time
I~ Pulldovn list I™ Logical

= Fil with DB table

List filing | [
Dictioharies
| | | |
1

Linkz with another documents

I
7

Field'z dividing

]
]

[~ List ] 8 I Cancel |

b. Place a colon in front of the variable name (1).
c. In the Calculation formula field, specify the variables for the DoReact function using quotes *,” - which will be used
with the button is clicked (2).
d. Click OK.
3. Drop-down list (3). In order to display a variable as a drop-down menu in the dialog box, you must configure it after adding it
to workspace, as follows (7):

gl
a. Click on the toolbar.
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b. Double click on the frame around the variable name. The Field options window will open.

Il Field's options |

Field [ [~ Man-edit I™ Hidden
Drefault Value I [~ Prev.value [ Autogain

Calculation Farmula

L]

% Shing " Integral [ Monetany unit
" Date " Real ™ Time

& FPulldowr izt 1 ™ Logical

I™ Fill with DE table 2

Ligt Filling |walue fealue?palues

Drictionaries

| | | | |
[

Links with another documents

I
1

Field'z dividing

|
|

[ List 1]4 I Cancel |

c. Check the Drop-down menu [Pulldown list] box (1).
d. If you would like to manually specify menu values, then you must enter the desired value in the Fill list field, using the
character “|” as the separator between values (2). To enter a large amount of text or to paste text from a file, click

—I and use the editor (see the section in APPENDIX 2. Entering text using the editor).
e. Click OK.

Creating variables is completed.
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Setting up workspace objects

After adding interface elements and variables to the workspace, it is necessary to configure them. Configuring interface elements
includes specifying their display variables (see the section on Setting object display variables).

To configure a variable, follow these steps:

gl
1. Click on the toolbar.

2. Double click the left mouse button on Variable menu item that you wish to set. The Field options window will open.
3. Enter the name of the variable in the Text field (1).

@ Note.

If there is a colon in front of the variable name (for example :var), the when creating a dialog box it will be displayed
as a button with the same name (var). At the same time, in the Calculation formula field (3) the variables for the
DoReact function will be displayed, delineated by the “|” character.

Il Field's options 6 x|

Field 1(¢Em AT C e
Default Value 2 1— [~ Prew.walue [ Autogain

Calculation Farmula
3 + Sting  Integral
Date i~ Real

[ Pulldawn list
T Fill with DE table

List filing |

Drictionaries

I | | |
[

Links with another documents

I
1

Field'z dividing

[ |
[

[ List 7 |i Cancel |

4. Enter the Default value in the field, of the variable that will be the default value (2).

Set the switches (3) to the position corresponding to the type of variable.

6. Specify the format for the variable. To do this you need to check one or more of the checkboxes in front of the format
corresponding to the variable (4).

7. If you do not want to allow the value of the variable in the dialog box to be changed, then check the Non-edit box (5).

If you want the value of the variable to be present in the dialog box, but not visible, then check the Hidden box (6).

9. Click OK (7).

v

©

Configuring variables is completed.
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Saving the dialog box form

To save the dialog box form, follow these steps:

1. Select File, then click Save (1) or Save as... (2) to save the file under a new name.

#1+ arp1.ARP - ARP Editor v1.1

Eile  Edit View
Mew... Ctrl+M
Open... Ctrl+-0
Save Ctrl+5
Save As..,
Grid's Print
1 arpl.ARP

Exit

I
2. Using the standard save file dialog, save the file with a .dlg extension [suffix].

#+ Save As
Save i_r1:| Poceon PSIM v| N I B b
Mame Date modified "
|| psim.sip.dbi 7/26/2022 1:55 PM
|_| psim.statestat.dbi £/12/2022 %:58 PM
| | psim.telegram.dbi 6/12/2022 9:53 PM
| | psim.videopsimclient.dbi T/26/2022 1:55 PM
| | psim.web.dbi 7/26/2022 1:55PM o,
< >
File name: |buﬁnn.dlg | | Save
Save astype: |All Files (") w Cancel

(D Note.

The file extension should be entered manually in this case.

1. Important!
In order to have access to the saved dialog form file in Axxon PSIM, it should be saved in the following folder: <Path to
installation directory of Axxon PSIM>/Program.

Saving the dialog bog form is completed.
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Accessing the dialog box from Axxon PSIM

To access the dialog box from Axxon PSIM, follow these steps:

1. Create an Operator query window under the Computer object in the Hardware tab of the Configure systems menu.

Architecturs

=] Alarm Message
BE-% Audio card 1[1]
M Backup archive 1[1]

1. Important!

When you create an Operator query window in the number field you should specify the name of the saved dialog box
form in the relevant director.

Operatar queny panel 2

Compriker o

LOCALHOST et

2. Go to the settings panel of the Operator query window.

Operator query panel 2
Computer | le
R

LOCALHOST

Ewent

1 Action executed

3 5

Undo

3. Specify the window coordinates: in the X field specify the coordinates along the horizontal axis, in the Y field specify the
coordinates along the vertical axis (1).

4. From the drop-down menu, in the Type column, select the type of object that trigger a dialog box (2).

5. From the drop-down menu, in the Number column, select the number of selected objected types (3).

6. Double click the left mouse button on the Name column (4). The cell will be automatically completed with the name of the
selected object.

7. Specify the action to be performed upon the occurrence of a specified event, in the Event column (5).

8. Click Apply.
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® Note.

In the example shown in the illustration above, the dialog box, created in the form, will be displayed from the macro.

| button
ket field

non-editable text figld

st Ivalue1 vI

cloze |

Dialog boxes are used for programming the Axxon PSIM software package. More information on the built-in programming language can
be found in the Axxon PSIM Software Package. Programming Guide.

Configuring the Operator query window is described in detail in the Administrator's Guide.
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Example of creating a dialog bog to count the
number of movements

This section provides an example of how to create a dialog box to count the number of movements. To create such a dialog box, follow
these steps:

1. Create a text field with the text Number of movements [Alarms:] (1).

Alarms:

param

2. Create variables (2).

gl
Click on the toolbar.

Double click on the frame around the variable name. The Variable field window will open.
5. For the name of the variable, name it param (1).

Mresopons ﬂ
1

Field param ﬂv‘ NDn-Edit) ™ Hidden

pW

Drefault Value [~ Prev.value [ Autogain
Calculation formula I |
% Shing " Integral ™ Monetary unit
" Date " Real [~ Time
I~ Pulldown list I™ Logical

T Fill with DB table

List filing | [
Dictionaries
| | | |
[

Linkz with anaother documents

|
1

Field'z dividing

|
|

[ List ok I Cancel |

6. Check the Non-edit box (2).
7. Save the file with the name motion.dlg in the following folder: <Axxon PSIM installation directory>\Program
8. Run Axxon PSIM.
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9. Create a directory try for the Operator query window in Axxon PSIM with the number motion.

Operator query panel motion

Caomputer WD

LOCALHOST it

Computer Mame
DESKTOP-79.. LOCALHOST

5§ Scrip S <
B %o Programs

|onEvent ("CaM", "1, "MD START") {

|DoReact ("DIALOG", "motion™, "CLOSE") ;

pa:cam=scr (atof (param)+1) ;

DoReact ("DIALOG", "motion™, "RUN", "param<™ + param + ">");}

Undo

11. Write the following code (2):

Onlnit(){

paranme" 0",

}

OnEvent (" CAM', " 1", " MD_START") {

DoReact (" DI ALOG', "noti on", " CLOSE") ;

par anrstr (at of (param +1) ;

DoReact (" DI ALOG', "noti on", "RUN', "paranx" + param + ">");}

12. From the drop-down Time zone menu, select Always (3).
13. Click Apply (4).

This script indicates that if the video camera in sector 1 detects movement, then a motion operator query window will open, showing
the number of movement alarms (param).

Alarms:
¥
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Working with badge forms

The ArpEdit utility supports work with the Visitor Management System (see Visitor Management System Module Settings and Operation
Guide) module and allows you to create badge forms and output them for printing.
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Creating a badge form

Before you start to create badge forms, you need to make sure that you have created an Access Control Service object, as well as
departments and users in Axxon PSIM.

To create badge forms in the Access Control Service, follow these steps:

1. Select the workspace section where the items will be added to the interface. Each section represents a single page.
2. Create the required number of variables, as follows:

ab
a. Add a variable to the workspace by clicking —| on the toolbar (1).

A+ 2 - ARP Editor v1.1
File Edit Wiew

: of 47 mm| ufw| || ojmlaN 5] 3] ool [E @]

Name > 1 =
b —T

Department

| Access level | level

=lolx]

«| |
I T

Ready

j=|
b. Click on the toolbar.
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c. Double click the left mouse button on the border of the Variable that you wish to set. This will open the Field options
window.

x
Field 1C

b ot-edit [ Hidden

Drefault Value [~ Prev.value [ Autogain
Calculation fommula I _l

% Shing " Integral ™ Monetary unit

" Date " Real [~ Time

I Pulldon lis I Logical

™| Fill vith DB bable

List filing | [

Dictionaries

I | | |
[

Links with ancther documents

|
1

Field'z dividing

[ |
|

™ List ok I Cancel |

d. In the Field box [field], enter the name of the variable corresponding to the table in the Axxon PSIM database: dbo.
OBJ_PERSON, from which data will be accessed for printing the badges (1).
3. Add the required design elements from the ArpEdit toolbar.
4. In order to allow the printing of photographs of employees on each pass for badge users, the Image should be set as follows:
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|
5. Select the required Image and click —| on the toolbar. The Field options window will open.
Field's options 1 x|

"C:\Program Fileshntellect\BmphPerzon " +id+" brip ! |

~ Coordinates —Alignment
™ Relative ™ inmm % Standard
% i v: [ O Left

%2 [16 vz:[10 " Fiight
@ %22 T Widthinspmboks | | ¢ Centered

Line's thicknes= II:I [ Hidden

[T Group
— Term
* Equal to zemo £~ More than zero
" ME to zero " Less than zeno

Figld... | k. I Cancel

6. In the Field options window, specify the following text string: “<Axxon PSIM installation directory>\bmp\Person\"+id+".
bmp” (1). When outputting the badge to the printer, the id variable will be automatically read from the data base, and
photography assigned to that ID by Axxon PSIM will be printed on the badge.

Design elements used for badge forms:

|

Name Description Function

Text Uneditable text field = Will display uneditable text information

=l NN

Name Description Function

Line | Line of any given length and direction Design element

gl

Name Description Function

Frame Rectangular frame of a specified size | Design element

L

Name Description Function

Square  Filled rectangle of a specified size = Design element

Name Description Function
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Image An image placed at a specified location = Insert user photographs on badge forms when printing

After adding all the required elements in the workspace, you must set the display variables (see section on Setting object display
variables).

Creating badge forms is completed.
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Saving badge forms

To save created badge forms, follow these steps:

1. From the File menu, select Save or Save as... to save a file with a new name.

#1+ arp1.ARP - ARP Editor v1.1

Eile  Edit View
Mew... Ctrl+M
Open... Ctrl+-0
Save Ctrl+5
Save As..,
Grid's Print
1 arpl.ARP

Exit

2. Using the standard save file menu, save the badge form file with a .arp extension.

Savein: | ¥ Desktop V| (€] ¥ [~
-
8 <~ =
By
231222 261222 LP
v
Fie name: | ITERIEGIE | | Save
Save astype: | ARP Files (".amp) b Cancel

Saving badge forms is complete.
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Printing badges

To output badges for printing, select Printer network [Print’s Grid] from the File menu.

#T+ arp1.ARP - ARP Editor v1.1

Eile  Edit View
Mew... Ctrl+M
Open.. Ctrl+CQ |
Save Ctrl+5
Save As..,
Grid's Print
1 arpl.ARP

Exit

Outputting the badge to the printer is completed.
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APPENDIX 1. Interface elements of the ArpEdit
utility
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System menu

The ArpEdit utility system menu provides access to the following functions:

1. File operations: creating, opening, saving, printing (1).

_Ei|e1 Edit 2 View 3
OEd OO H C

2. Text editing features (2).
3. AprEdit utility window display settings. In this menu, you can enable or disable the display of the toolbar and status bar (3).
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Toolbar

The main way to manipulate objects in ArpEdit is via a toolbar, that has buttons to control the utility.
&+ arp1.ARP - ARP Editor v1.1 =

File Edit Wiew

DEd 0D H O 7 Aaab — | Om&E 25 Amh=

L

Description of the buttons in the ArpEdit utility toolbar:

Button image Name | Function
Manipulation of AmpEdit documents

D Mew Create new document

E,"' Open Open file

E Save Save text document

Managing an ArpEgit document
D Crient vertically Whenthis element is activated, the page is oriented vertically
Ijl Crient horizontally When this element is activated, the page is criented
horizontally

|—| Display sections Displays sections [pages) of the document [up to five)
:|:|: Show grid Displays the mapping grid for the workspace

31- Snapto grid Snaps the object to the grid

ﬁ,} Zoom in Increases the size of objects in the workspace
ﬁ Zoom out Decreases the size of objects in the workspace

= Display options Opens a settings window with display settings for the
— selected object

123 Sort fields Displays the fields in order by section

Adding objects to the ArpEdit workspace

Aa Text Insert a text field in the workspace

ah Field Insert a Variahle [editable text field) in the workspace
- Horizontal line Insert a horizontal line in the workspace

| Vertical line Insert a vertical line in the workspace

|:| Frame Insert a frame in the workspace

[ | Sguare Insert a square (shaded rectangle) in the workspace
Image Insert an image in the workspace

., Lire Insert a line in any direction in the workspace
T Object management

ﬁq Separate text Separate text using a linefeed as a separator

JE Delete Delete the selected object
g Form Access the editor for variable parameters

Form options Set parameters for the connection with the data source
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Workspace

The ArpEdit utility workspace is designed for the placement of objects in ArpEdit. When the Show sections button is activated, the
workspace will be divided into sections by horizontal lines.

& arp1.ARP - ARP Editor v1.1

File Edit View
held Oo H o -+ A 4z ah — | O rE N Ao mmss

< 4

Ready NUM

Each section will have its own page. To start editing a section, select it by licking on the dividing line with the left mouse button. The
selected section will be highlighted in blue.
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APPENDIX 2. Entering text using the editor

You can enter text in the variable settings using the built-in ArpEdit editor. This editor should be used when you want to fill in a text
field with data from a text file or a large amount of data.

To enter text using the editor, follow these steps:

1. Click —I next to the text field.

x

— Coordinates — Alignment
[ Relative ™ in & Standard
w18 v 6 O Left
x2: [28 vz [s £ Right
¥ %2¥2 T Widthin spmbols | | Centered
Line's thickness IEI [~ Hidden

[T Group

— Term
¥ Equal to zero " More than zemo
" ME to zem " Less than zemo

Field... | k. I Cancel

2. Open the Editor window.

o B
2
2 Syntax ‘. 3 Cancel |

3. Enter text in the text field (1).

4. If you want to paste the text into a text field from a text file, then click File... (2) using the standard open file dialog box,
select the required text file. Text from the selected file will appear in the text field (1).

5. Click OK (3).

Entering text using the editor is completed.
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Configuration check tool

The Configuration check tool is designed for checking the settings of all created objects in the Axxon PSIM™ software and restoring the
correct configuration if any changes occurred. Restoring is performed from the configuration template which can be created at any
moment in accordance with current settings.
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Starting and shutting down the Configuration
check tool

To start the Configuration check tool, do the following:

1. Go to the Interfaces tab of the System settings dialog box.
2. Create the Configuration check object on the base of the Display object.

Architecturs Hardware Interfaces Programming

Wizard

Audio player

Backup archive panel

Captions search
Expand tree Charts
Collapse tree C_ﬂnﬁguration check
Display manager

Delete chject Event viewer

0 i

External window
HTML Interface

Incident manager

Create folder...

Save
Find... Intercom Control Monitor
Live sound switch

Map

Monitor

Load configuration...

gm0l

Save configuration...

Operator protocol

Receipt viewer

'!EIH

Scene

SIP-panel

State statistics
Telemetry control panel

Display

Configuration check 1

Dizplay [ Dizable

4. To configure the position of the Configuration check object, set the coordinates of upper left corner in X:, Y: fields and
values of window’s width and height in W:, H: fields, and select the computer monitor for which the coordinates are set.

Apply

5. To save the changes, click the

As a result the Verifying configuration tool dialog box is displayed.
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Configuration check utility

File  Configuration Debug

Computer COMPUTER
[ ]Backup archive 1
[JBackup audio archive 1
[JVideo capture device 1
[IMEDIA_SERVER COMPUTER
- Audio card 1

* Parameters from configuration{cument )
_marker
arch_days
cam_id
client
connection
disable_protocol
display_id
drives
drives_a
flags
guid
is_backup
is_load
iz6dbit
local_protocol
mic_id
name
parent_id
password

0

0

1

CA

CA

{BB31D7B1-6A28-ED 11-866E-000C29853B3
0

0

Computer COMPUTER

Parameters from configuration{cument )

Template Digtinguish

Remove differences

* Parameters from template
_marker
arch_days
cam_id
client
connection
disable_protocol
display_id
drives
drives_a
flags
guid
is_backup
is_load
is64bit
local_protocal
mic_id
name
parent_id
P

0

0

1

CA

CA

{BEB31D7B1-6A28-ED 11-866E-000C29853B3
0

0

Computer COMPUTER

| marker

To shut down the tool, click the . button on the main control panel of Axxon PSIM software and select the Close all menu item;
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Configuration check tool interface description

The dialog box of the Configuration check tool has four main interface elements:

1. The toolbar (1).
The tool’s control menu is located here.
2. The objects tree of Axxon PSIM software (2).
The objects tree of Axxon PSIM software is displayed here. Clicking the left mouse button on any object in the objects tree, the
configuration of its parameters is displayed in parameters field (points 3-4).
3. The field of object parameters from Axxon PSIM configuration (3).
The current configuration is displayed in this field. These parameters are not available for editing.
4. The field of object parameters from a template (4).

Parameters of the selected object from the configuration template field are displayed here. These parameters are available for editing.

@ Note.

At the first start of the Configuration check tool, the current configuration of selected object is displayed in this field.
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Configuration check utility

File  Configuration Debug

284 Computer COMPUTER
[ |Backup archive 1
: [IBackup audio archive 1
[video capture device 1
CIMEDIA_SERVER COMPUTER
-] Audio card 1

(C_ Parameters from configuration{curment )

_marker

drives_a

0

0
1
i,
CA

{BB31D7B1-6A28-ED11-866E-000C29853B3

0
0
Computer COMPUTER
-
Parameters from configuration{curment )
kTemplate Distinguish Remove differences 3 _/‘
fﬁm Trom templale
_marker —\
arch_days
cam_id
cliert 1]
connection
dizable_protocol 0
display_id 1
drives CA
drives_a C:A
flags
guid {BEB31D7B1-6A28-ED11-866E-000C29853B3
is_backup
iz_|oad
iz 64bit 0
local_protocol 0
mic_id
name Computer COMPUTER
parent_id 4

<

i macowned

139




Using the Configuration check tool

To start the operation, start the Configuration check tool (see the Starting and shutting down the Configuration check tool section).
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Creating a template

To create a template in the Configuration check tool, do the following:

1.

2.

In the objects tree, set the checkboxes next to those objects which parameters configuration will be included in a template.

=8l Computer CC
El Video capture device 1

. IMEDIA_SERVER COMPUTER

:..[ | Backup archive 1

..[ | Backup audio archive 1

-] Audio card 1

Click the left mouse button upon the object which parameters configuration is to be edited.

(D Note.

The set checkbox next to the required object is an obligatory term in order to edit the parameters.

As a result there is a list of object parameters with values, available for editing in the parameters from template field.

{D Note.

In the parameters from Axxon PSIM configuration field there is a list of object parameters with values set in Axxon
PSIM software. They can not be edited.

* Parameters from configuration{curment )

_marker

arch_days

cam_id

client 0

connection

disable_protocol 0

display_id

drives CA

drives_a CA

flags

guid {BB31D7B1-6A28-ED11-866E-000C29853B3
is_backup

ig_load

izG4bit 0

local_protocol 0

mic_id

AAMA Cammdear COMPLITFR

{D Note.

At the first start of the Configuration check tool, the current configuration of selected object is displayed in this field.

_marker '
brand
fimmware

flags

quid {118098E6-8418-ED11-96C 1-BBA3866BCH2:
ip

max_speed

model
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Edit the object parameters. To edit the selected parameter, click the left mouse button upon the corresponding line with its
value and edit it.

Repeat steps 3 for all objects, which parameters configurations are to be edited
Go to the File menu of the control panel and select the Save template item.

Configuration check utility

File | Ceonfiguration Deb

Load template
Save template S

6. Name a file and select the storage directory in the appeared window.

al Save As

€« v 4 [E > ThisPC > Documents »

v | @ Search Documents -l
Organize v Newfolder

~
A Name Date modified Type Size
~ 3 Quick access

SQL Server Management Studio
I Deskiop B

Support
¥ Downioads Visual Studie 2017

File folder
File folder

File folder

%] Documents
&) Pictures
4.1 AxxonPSIM
en
inc manager Rin
TaT
@ OneDrive - Persor

[ This PC

v

File name: | Templatexml

Save as type: | Xml files (".xml)

+ Hide Folders

7. Click the Save button.

The template is now created.
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Downloading and editing the template

To download and edit the template, do the following:

1. Go to the File menu on the control panel and select the Load template item.

Configuration check utility

File | Ceonfiguration Debug
| Load template
1
Save template
— = MPUT
2. Select a template file in the appeared window and click the Open button.
5l Open X
4 & » ThisPC > Documents > v O Search Documents p
Organize »  New folder =~ T @
Name h Date modified Type Size
# Quick access _ )
I Desktop S0L Server Management Studic F!'EfE'[‘E\
Support File folder
& Downloads Visual Studio 2017 File folder
[ Documents ] Templatexm| XML Document 4KB
&=| Pictures
411 AxxonP5IM
en
inc manager Rimm;
TaT
@ OneDrive - Personal
[ This PC
¥ Network
File name: | T | i files (i) v
The objects tree is displayed as a result. The active checkbox is next to the objects which configuration has been saved in the
template.

=-[]Computer COMPLUTER

T [«]Video capture device 1
[ ]Backup archive 1

i.[ ] Backup audio archive 1

-] Audio card 1

3. To edit the template, repeat steps 1-7 of the Creating a template section.

The template is now downloaded and edited.
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Verifying and correcting the configuration

To verify the current configuration of objects in Axxon PSIM software and restore it from the template, do the following:

1. Download the template for which the object configuration is to be verified in Axxon PSIM software (see the Downloading and
editing the template section).

2. Go to the Configuration menu on the control panel and click the Test button.

Configuration check utility

File | Configuration | Debug

sOq Test
..

Correct

|:| Backup archive 1

|:| Backup audio archive 1
-] Audio card 1

As a result the objects which current configuration in Axxon PSIM software differs from that one in the template will be marked
red in the objects tree.

Configuration check utility

File  Cenfiguration Debug

Computer COMPUTER
Video capture device 1

Backup archive 1
Backup audio archive 1
Audio card 1

3. To view object parameters in the template which values are different from those ones in the Axxon PSIM software, click the left
mouse button upon the object marked red in the objects tree and go to the parameters from the template field.
4. Click the Distinguish button in the Template field.

Template Distinguish Remove differences

As a result the parameters which values are different from those ones in Axxon PSIM software are moved to the Differences

list.
| F il —
Differences
_marker ethnetn
flags 5
guid {678CF252-0828
name. MEDIA SERVER
marker
5. Correction (if necessary) of these parameter in Axxon PSIM software for those ones from the template may be performed in
two ways:

a. Click the Remove differences button in the Template field.

Template Diistinguish Remove differences

144



b. Go to the Configuration menu on the control panel and select the Correct item.

Configuration check utility

File | Configuration | Debug
(= Test

'ﬂ": Correct JI':1F'LITEH

Backup archive 1
Backup audio archive 1
-] Audio card 1

The parameter configuration from Axxon PSIM templates is now verified and corrected.
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Index.exe utility for reindexing archive files

146



The purpose of Index.exe utility

Index.exe utility reindexes archive files with big data array without restarting the Axxon PSIM software.

@ Note.

Another way to perform reindexing of archive files is to shut down the Axxon PSIM software and delete the INDEX folder in
the VIDEO folder on the disk with archive. Indexes will be rebuild automatically after the Axxon PSIM startup. This method is

equal to using of the index.exe utility.
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Starting and shutting down the utility

To start reindexing utility run index.exe executive file in the Modules64 folder that is in the catalogue of the Axxon PSIM software
installation, for example, «C: \Program Files\Axxon PSIM\Modules64>.

As a result the window of index.exe utility is displayed:

®m Archive indexing — >

Disks For reindexing

8. 80 &:: B5ekect Al

To stop working with index.exe utility click Close.

148



Using the Index.exe utility

1 Attention!

Before you start working with the utility check the value of IndexRebuilding parameter in
HKLM\SOFTWARE\AxxonSoft\PSIM\Video for 32-bit systems (HKLM\SOFTWARE\Wow6432Node\AxxonSoft\PSIM\Video for 64-

bit) section of OS Windows registry: by default it should be 0. If the parameter value differs from the value by default, you
should change it to 0, otherwise the utility will not idex the archive.

To reindex archive files after its changing (for example, after copying new video recordings to one or several archive disks), do the
following:

1. Start index.exe utility (see Starting and shutting down the utility section).

2. In appeared window select archive disks for reindexing by setting checkbox next to required disks (1). Check Select All to set
all checkboxes (2).

3. To start reindexing click the Start button (3).
g aeilath

= Archive indexing — *

Disks For reindexing

cih i Ed Select all

1 2

Skart

g 4

Rebuilding, please wait ...
Drrives DuY .. OK! [Time: 00:00:00]
Drive: EiY ... QK [Time: 00:00:00]

Drrives Y Lo 0K [Time: 00:00:00] L
Total time: 00:00:00
Complete,

G) Note.

At the time of reindexing all the elements of utility window are not active.

4. Rebuilding process is displayed by progress bar (4) and in the text field (5).
5. When you finish reindexing, shut the window of utility.

Reindexing of archive files is completed.

To reindex archive files without using the dialog box, in the command line start index.exe utility with parameters, for instance, index.
exe C, D command will reindex archive files on disks C and D. To reindex archive files on all disks, use the all parameter.
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The shedule.exe utility for creating a replication
query file
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The purpose of the shedule.exe utility

The shedule.exe utility is designed for creating a query file on the Server-Receiver while replicating the archive on unconnected
Servers (see Replicating archive from unconnected servers using the removable storage section).
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Starting and shutting-down the schedule.exe
utility
To start the utility start the schedule.exe file in the Tools\Replication folder of the Axxon PSIM installation directory. For example:

C:\Program Files\Axxon PSIM\Tools\Replication\shedule.exe.

1+ + | Replication - O
Home Share Wiew
« v « fxxon PSIM » Tools » Replication v ) f Search Replication
~
3 Mame Date modified Type Size
# Quick access
UsbTool File folder

[ Desktop N ol s
Application exten... 1,431 KB

& Downloads Application 71 KB

[=| Documents | ] shedule.exe.config CONFIG File 2KB

=/ Pictures
Dol
Editor-Debugger
JSeript
XKML file prepara

As the result the dialog window of the schedule.exe utility is opened.
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o) Replication tasks control
File
Guery executor:
| User 1 o | |

Guery
Computer: Camera:
'LOCALHOST v

Time period

(D Note.

The error message is displayed at opening the schedule.exe utility when users or the Camera objects are not created in the A

xxon PSIM software under the Computer/LOCALHOST object corresponding to the Receiver. It is needed to create required
objects and restart the system.

To close the schedule.exe utility, click the .ZJ button or select Exit in the File menu.

82! Replication tasks control

File

Open file
Open drive
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Using the schedule.exe utility
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Creating the query file for replication

To create the query file do the following:

1. Connect the removable storage to the Receiver.
2. Select the user registered the Axxon PSIM™ software in the Query executor drop-down list (1).

85! Replication tasks control — O X
p

File

Query executor: 1 5 s
|lher1 v| | Add || Delete |
Query
Computer: 2 Camera: 3
|LOCALHOST -
Time period
From: Ta:
[250820220 - | [260820220 - |4

» LOCALHOST Camera 1 2022-08-26705:00:00.00000  2022-08-26T09:00:00.00000
LOCALHOST Camerza 2 2022-08-26T705:00:00.00000  2022-08-26T0%:00:00.00000
LOCALHOST Camerz 2 2022-08-26709:00:00.00000  2022-08-26T0%:00:00.00000
LOCALHOST Camera 4 2022-08-26705:00:00.00000  2022-08-26T0%:00:00.00000

Select the Computer object corresponding to the Data source in the Computer drop-down list (2).
In the corresponding drop-down list select the Camera object the archive of which is to be copied (3).
Specify the time period for which the archive from selected camera is to be copied in the From: and To: fields using the mask

nkw

or calendar that is displayed by clicking the Z‘ button (4).
6. Click the Add button (5).
The task is added to the list (6).

(D Note.

Select the task and click the Delete button to delete it from the list (7).

7. Repeat steps 2-6 for all required Sources.
8. Save the query file.

The query file is now created.
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Saving the query file
To save the query file do the following:

1. Select Save in the File menu.

a5' Replication tasks control

Fie |

Open file

Open drive
| Save Ctrl+5

Exit |
TTEOTTTOTT i

2. Select the removable disk where the query file is to be saved in the drop-down list of the opened dialog box (1).

Select USE drive d&y 'User 1' >

E:\ FLASH [FAT32] - Total 14.44 GB, Free 14.44 GH 1 b

(D Note.

The Removable disks are not found message will be displayed if the removable storage is not found while saving the
query file.

(D Note.

If there is the PSIMBackup folder on the removable storage, then the dialog box asking to delete this folder is
displayed. Click the OK button.

3. Click the OK button (2). The query file is saved on the selected disk.

The query file is now saved.
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Opening the query file
To open the query file do one of the following:

1. Specify the disk where the query file is. For this:
2. Select Open drive in the File menu.

85 Replication tasks control

File

Open file

Open drive
Save (Ctrl+5

Exit

TR T

3. Select the query file in the drop-down list (1).
| Select USE drive 'USER -

| F\FLASH [FATZE2]- Total 14.44 GE, Free 14.44 GE 1 e

2 )4 | Cancel

(D Note.

The Removable disks are not found message will be displayed if the removable storage is not found while openning
the query file.

4. Click the OK button (2).

The utility detects and opens the query file which is in the root of selected disk.
5. Select the query file manually. For this:
6. Select Open file in the File menu.

85 Replication tasks control
File

Dpen file )

| Upen arive |

Save Ctri+5

Exit

TR T

7. Select the psim_task.xml file containing the query parameters using the standard opening dialog.

The query file is now opened.
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The SyncProtocol.exe utility to synchronize event
log database
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The purpose of the SyncProtocol.exe utility.
Starting and shutting-down the utility

Purpose

The SyncProtocol.exe utility is designed to synchronize Server/Client Event log database with databases of other Servers/Clients by
command if the auto synchronization is disabled.

The auto synchronization is disabled on the Computer settings panel using the Only local protocols checkbox. If this checkbox is set
checked, then the auto synchronization is not performed - see Configuring events logging.

Before starting synchronization using the SyncProtocol.exe utility it is required to configure synchronization on the Computer settings
panel by specifying the computers for synchronization and the Event Viewer database connection string — see Configuring the Event
Viewer databases synchronization.

There is no synchronization with computers for which sending events is disabled in the Architecture tab (see Configuring the
interaction of distributed system components). If the Send events checkbox is set checked, but checkboxes for all the events are set
unchecked, then the events that cannot be disabled will be synchronized (for instance, SLAVE and macro events).

Starting and shutting-down the utility

Start the SyncProtocol.exe utility from the Tools folder in the Axxon PSIM installation folder (by default, C:\Program Files (x86)\Axxon
PSIM\Tools).

The utility dialog box is shown in the figure.

Synchronization of protocols by means of SCOL Server X

Synchronize

Synchronization log:

To shut down the SyncProtocol.exe utility click the 5' button in the upper-right corner of the window.
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Synchronization of event log database using the
SyncProtocol.exe utility

Synchronize the event log database using the SyncProtocol.exe utility as follows:

1. Preconfigure the system and start the SyncProtocol.exe utility (see The purpose of the SyncProtocol.exe utility. Starting and

shutting-down the utility).
2. Click the Synchronize button (1).

Synchronization of protocols by meansi'nfﬂ_!_‘-r = _£|
| Synchronize 1 I

Synchronization log: 2

Add linked server:5-JAKEEW\SQLEXPRESSZ2014 ﬂ
Ok, SQL:EXEC sp_addlinkedserver "5-JAKEEWISOLEXPRESSZ014",'SCL Server’

Add linked login:sa

Ok SOL:EREC sp_addlinkedsrvlogin 'S-JAKEEV SOLEXPRESS2014', False', MULL, '
synchro From:S-JAKEEY\SQLEXPRESSZ01 4. inkellect ko (localSQOLEXPRESSZ014.i
O SQLiselect * into PROTOCOL_TEMP from [S-JAKEEY,SQLEXPRESSZ014].inte
OF SOL:CREATE NOMCLUSTERED INDEY [1¥_protacol_pk] OM [dba]. [PROTOCOL
©K SQL:CREATE NOMCLUSTERED IMDEX [1%_pratacol_pk] &M [dbo]. [PROTOCOL
Ok SQLIEXEC sp_droplinkedsrvlogin 'S-JAKEEVSOLEXPRESS2014°, MULL

OF SQLEXEC sp_dropserver 'S-JAKEEVYSQLEXPRESS2014'

End

<] ,
[

|

3. The information on the synchronization process is displayed in the Synchronization log field (2).

4. When the process is completed shutdown the utility by clicking the il button.

The event log database is now synchronized using the SyncProtocol.exe utility.
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The Axxon Player utility for viewing and
converting the video archive

Please see the documentation here.
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The openRTSP.exe utility for checking RTSP
workability

The openRTSP.exe utility is a console application without a graphical user interface. This utility is intended for use in scripts to check
workability of the RTSP Server module. Please visit http://www.live555.com/openRTSP/ for details about the utility.

The openRTSP.exe file is located in the <Axxon PSIM installation directory>\Tools folder.

An example of a script to test the workability of RTSP is given below. This script runs the openRTSP.exe utility by timer, then the utility
takes 1 sec of video and checks the status of the RTSP Server. If a rejection from the RTSP Server itself is received, the
StreamingServer.run process is restarted.

(D Note.

Create and configure the Timer object for the required check period - see Creating and using the Timer object.

function check_can(addr)

{
var scmd = "./Tool s/ openRTSP.exe -V -D 10 -d 1 "+addr;
DebugLogString("run:"+scnd);

var s = run_cnd_ti meout (scrd, 10000);

DebugLogString(s);
if(s.indexO ("Receiving streaned data")< 0)
{
DebugLogString("restarting");
var nmsg = CreateMsg();
nmsg. StringToMsg(" SLAVE| COVP_NAME| EXECUTE]| r est art <1>, cormand<st r eam ngserver.run>"); //change COVP_NAME to
the name of the conputer where the process runs
DoReact (nsQ) ;
}
}

i f (Event. SourceType == "LOCAL_TI MER' && Event. Sourceld == "TEST_RTSP")
{

check_can("rtsp://127.0.0.1:5544/1"); //the link is forned as described in the "Configuring the RTSP Server
Modul e" section

check_canm("rtsp://127.0.0. 1: 5545/ 4");
}
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The Convert.exe utility for correcting modification
dates of video archives
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The purpose of the Convert.exe utility

The Convert.exe utility is designed for restoring changed creation dates of video archive files. For example, file creation dates may be
changed (corrupted) while transferring an archive from one computer to another. This may lead to incorrect playback of the archive.
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Starting and shutting-down the Convert.exe utility

The Convert.exe utility can be operated in two modes:

1. Correction of records creation dates. To use this mode, start the utility from the Tools folder of the Axxon PSIM installation
folder. Example: C:\Program Files (x86)\Axxon PSIM\Tools\Convert.exe.

2. Correction of records creation and modification dates. To use this mode, start the utility from the Tools folder of the Axxon PSIM
installation folder with the -FULLMODE parameter.

The Convert.exe utility dialog box will open.

B Ch\Program Files (x86)\Axxon PSIM\Tools\Convert.exe - O x

To shutdown the Convert.exe utility, click the Close button.
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Restoring changed creation dates using the
Convert.exe utility

The Convert.exe utility allows restoring the creation date of a video archive file. To make the restoration, start the utility (see the Starti
ng and shutting-down the Convert.exe utility section). A console window will open starting the process of searching the Video folder on
each of the available disks. Then, replacing of modification date for creation date will start automatically. This process will take some
time depending on the archive size. For example, restoring dates in a 500 MB archive will take about 10 seconds. When all dates are

replaced, the Convert.exe window will close by itself.
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Working with the Convert.exe utility using the
command prompt

One can work with the Convert.exe utility using Windows command prompt. The following startup parameters are in use:

bl N S

TZ +hh:mm - changing date of file creation and modification for hh hours and mm minutes.

PATH - specifies the path to the archive folder with files date of creation (modification) of which is to be restored.

FULLMODE - running the utility in order to correct the date of creation and modification.

FORMAT is similar to FULLMODE. It also converts archive files to a format optimized for high-resolution archiving. The
execution time of the FORMAT operation is comparable the the time required for a full conversion of the archive on the disk,
because it requires reading every frame and creating a backup copy of the files while they are being converted. After the
format of the archive or record has been updated, the execution time of subsequent conversions in FULLMODE will become the
same as during an ordinary conversion.

Examples of commands for working with the Convert.exe utility using the command prompt:

1.

Convert.exe PATH "H:\Video\03-09-12 15" FULLMODE
Running this command the Convert.exe utility will restore the date of file creation and modification in H:\Video\03-09-12 15
folder.

. Convert.exe TZ +01:00

Running this command the time of file creation and modification will change for an hour. For instance, the *17-09-12 13" folder
will be renamed as “17-09-12 14”".

Note.

These examples assume using a command prompt in <Axxon PSIM>\ Tools folder.
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The SignCheck.exe utility for checking the
authenticity of exported frames
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Starting and shutting-down the SignCheck.exe
utility
To start the SignCheck.exe utility, do one of the following:

1. Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Tools, then Check Digital

Signature.

The SignCheck.exe utility is available from the Start menu with the following installation types of the Axxon PSIM software:
Server, Remote administrator workstation, Remote client.

A

B Acon PSIM

Additional Utilities for the PSIM soft...

Administrator's guide

| Advanced settings utility
T Axon player

Asocon PSIM
FfooconSoft EXPERT
Brief operator's guide
Check digital signature
Collect system's data
Configuring security components gu...
Create dialog windows
Custom type editor

FPS tes

B e [J

=
=]
=

Hardware and Software Module Inte...

-
e |
=

Help Emergency Settings Guide

=
=
g

Operator's guide

£ Type here to search

2. Start the utility from the Tools folder of the Axxon PSIM program folder. Example: C:\Axxon PSIM\Tools\SignCheck.exe.

The SignCheck dialog box will open.
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E§ SignCheck X

-]

To close the SignCheck.exe utility, click the Close button.
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The purpose of the SignCheck.exe utility

The SignCheck.exe utility is designed for checking the authenticity of a frame exported into BMP or JPEG format using the Converter.
exe utility.
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Using the SignCheck.exe utility

To verify the frame authenticity, do the following:

1. Start the utility (see Starting and shutting-down the SignCheck.exe utility section).
=

2. Select the file with exported frame to check, using the button and a standard dialog box for opening files.

The SignCheck window will show the information about the selected frame.

4 SignCheck X

|E:'\E:-:pcurt'xe:-:pnrt.ipg

Time : 19-08-22 15:34:03
Camera: 1

System ; AY| Converter
Few: M

Computer : ''51

Uzer: COMPUTER

]9

The following information is displayed:

AxxonSoft export frame - digital signature title.

Frame time - date and time stamp of this frame in the recording.
Export time - date and time of exporting this frame to a file.
Camera - ID of the camera from which the recording was made.
System - the software that made the recording.

Computer — name of the computer this software is installed on.
User - user name of this computer.

Nounhwh e

If the frame cannot be authenticated, or the digital signature is missing, the "Verification failed” message will be displayed.
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The idb.exe utility for converting databases,
selecting database templates and making backup
copies of databases
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The purpose of the idb.exe utility

The idb.exe utility is designed for database administration in Axxon PSIM software. It provides the following functionality:

Connecting to the Axxon PSIM database.

Setting up the database synchronization.

Creating backup copies of a database.

Restoring a database from its backup copy.

Changing the database template (see Interface elements of the idb.exe window).
Separating the events log into an individual database.

ok
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Running and shutting down the utility

Shut down Axxon PSIM before running the idb.exe utility.

The idb.exe utility is run from the Axxon PSIM installation directory. For example: «C:\ Program Files \Axxon PSIM\idb.exe».

The idb.exe dialog box will open.

{ IDB - [DESKTOP-7932GG9]

Description:

«~ | | "Axxon PSIM® main database:

Select data source:

Basic data

Use

Connection string: Move database Configure

| Provider =SQLNCLI11. 1;Integrated Security =55PI;Persist Security Info=False;1

Select dbi-file: Select ddi-file:
| C:\Program Files (x86) WAxxon PSIMpsim.dbi ‘ = | C:\Program Files (x86)\Axxon PSIM\Languages'enipsim.ddi =
Select action
Create backup copy (M5 5QL) Restore from backup (M5 SQL)

[ clear protocols

Additional tools

Update database Create dbi-file

Protocol

To confirm the changes and shut down the utility, click the OK button. To shut down the utility without saving the changes, click the CI

ose button (E )
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Interface elements of the idb.exe window

The figure below shows the idb.exe dialog box.

'{ IDB - [DESKTOP

Select data source: Description:

Basic data 1 ~ | | "Axwon PSIM® main database: 2
[Huse 3 4 2

Connection string: 6 Move database Configure

| Provider =SCQLNCLI11. 1;Integrated Security =55P1;Persist Security Info=False;1

Select dbi-file: T

Select ddi-file: 8

| C:\Program Files (x86) Axxon PSIMpsim. dbi

T

| = | C:\Program Files (x86)\Axxon PSIM\Languagesen\psim.ddi

Select action g

Create backup copy (M5 5QL)

[ cClear protocols 4 4

Additional tools

Update database

10

Restore from backup (M5 SQL)

12 13 Create dbi-file

Protocol

14

15 o]

The table describes the interface elements of the idb.exe utility dialog box.

N2 | Element Description Default value Allowed values
name
1 | Select The drop-down list for selecting the database: local Configuration dat = Basic data Basic data - local Configuration d
data abase, Event protocol database, or a remote database for atabase
source synchronization

Synchro source - remote database
for synchronization

Protocol - Event protocol database
Titles - Captions database

Other values are used when working
with vertical solutions
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2 | Description

3 |Use

4 | Move
database

5 | Configure

6 | The Connec
tion string i
nformation
field

The information field that displays the description of the selected data
source from the Select data source dropdown list

The checkbox for enabling or disabling the selected database usage.
When set, the Configure button becomes active, which is used for
setting up the connection to the database

The button used to transfer MS SQL Server database files (.mdf and .
Idf) to the specified folder. The user should have the rights to create
files in this folder. When the files are moved, the database is
automatically attached.

Note. It is possible to move only the local DB (Basic data data source).

When using a remote DB (Synchro source data source), files can not
be moved

The button opens the Data Link Properties dialog box to configure
the database connection. This button is active if the Use checkbox is
set

The information field displaying the summary about the database
connection parameters
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Axxon PSIM main database

Checked

Active

Active

Depends on the database
connection parameters, the server
configuration or Remote
Administrator's workstation
configuration

"Axxon PSIM" main database -
local Configuration database

Synchro source - remote database
for synchronization

"Axxon PSIM" system's external
protocols database - Event
protocol database

Titles database - Captions databa
se

Other values depend on the
availability of the databases for the
installed vertical solutions.

Checked - database is connected
Clear - database is not connected

Active - the idb.exe utility is
connected to the MS SQL format
database

Inactive - the idb.exe utility is not
connected to the MS SQL format
database

Active - the idb.exe utility is
connected to the database

Inactive - the idb.exe utility is not
connected to the database

Displays the combination of the
following parameters:

Provider, Integrated Security,
Persist Security Info, Data Source.

The Provider parameter can take

the following values:

® SQLOLEDB.1 - when using the
MS SQL server format
database;

® Microsoft.Jet.OLEDB.4.0 -
when using the MS Access
format server database

Other values are not used.

The Integrated Security parameter

can take the following values:

® SSPI - authentication on MS
SQL server using Windows
account information;

® parameter not shown -
authentication on MS SQL
server using the user login
/password, or using MS Access
format database

The Persist Security Info

parameter can take the following
values:

® True - allow saving the
password for automatic
connection to the database;

® False - do not allow saving the
password for automatic
connection to the database

The Data Source parameter can

take the following values:

® the name of the MS SQL
server used for managing the
database;

® the path to the .mdb file of the
MS Access format database



10

11

12

13

14

15

Information
field and

the Select
dbi-file butt
on

Information
field and

the Select
dbi-file butt
on

Create
backup
copy (MS
SQL)

Restore
from
backup
(MS sQL)

Clear
protocols

Update
database

Create dbi-
file

The Protoc
ol informatio
n table

OK

The information field and the button for selecting and displaying the
database structure .dbi file. The updated database will have the
structure specified in this file

The information field and the button for selecting and displaying the
information about the .ddi file with system objects, events and
reactions

The button for starting the process of creating a backup copy of the
database. This button is active if the idb.exe utility is connected to the
MS SQL format database

The button for restoring the database from a previously created backup

The checkbox that excludes the Event log database from the created
database backup copy. It is recommended to set this checkbox if the
size of the Event log database is too large, and there is no need to
include the Event log in the backup copy.

The setting is available only for Axxon PSIM base database

The button for starting the process of updating the database structure.
The structure is updated according to the .dbi file specified in the Selec
t dbi-file field

The button for creating a database structure .dbi file (template)

The information table that displays the progress of database
processing: converting, structure updating, creating backup copy, etc.

The button for saving the database connection parameters and
shutting down the idb.exe utility
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C:\Program Files\Axxon PSIM\psim.
dbi

C:\Program Files\Axxon
PSIM\Languages\en\Axxon PSIM.ddi

Active

Active

Active

Active

Empty

Active

The full path to the .dbi file

The full path to the .dbi file

Active - the idb.exe utility is
connected to the MS SQL format
database

Inactive - the idb.exe utility is not
connected to the MS SQL format
database

Active - the idb.exe utility is
connected to the MS SQL format
database

Inactive - the idb.exe utility is not
connected to the MS SQL format
database

Checked - the database backup
copy does not include the Event log
database

Clear - the database backup copy
includes the Event log database

Active - the idb.exe utility is
connected to the Configuration dat
abase

Inactive - the idb.exe utility is not
connected to the Configuration dat
abase

Active - .dbi file creation is allowed

Information messages about the
progress of the database processing.

The blue “i” icon indicates that the
processing step has been
successfully completed

The red “!” icon indicates the errors
in the processing step

A blue tick icon indicates the
completion of the processing

Active - saving database connection
parameters and shutting down the
idb.exe utility is allowed

Inactive - the utility is still
processing the database



Using the idb.exe utility

The idb.exe utility allows the administration of the databases of the Axxon PSIM system. Instructions on how to use the utility for
administering databases are given in Axxon PSIM™ software database management section.

(D Note.

The Windows Firewall/ICS service is to be enabled to use the idb.exe utility.

When you switch between databases using the Select data source drop-down list (see Interface elements of the idb.exe window),
note that the specified parameters for connecting to the currently selected database are partially reset. This is due to the Microsoft
security policy. In order for the settings in the Connection string field to be saved, do the following before you switch to the
administration of another database:

1. Make sure that the database which connection settings should be saved is selected in the Select data source list (1).
™{ IDB - [DESKTOP-7

Select data source: [
Basic data 1 w
Lse 2

Connection string: Move database Configure

| Provider =SQLOLEDE. 1;Integrated Security =55PI;Persist Security Info=True;In

2. Click the Configure button (2).
3. In the window that opens, go to the All tab (3).
|EE| Data Link Properties *

Provider Cormection Advanced Al 3

These are the initialization properties for this type of data. To edit a
value, select a property, then choose Edit Value below.

MName Walue 2
| Initial Catalog intellect
i Initial File Name
| Integrated Security SSP|
Locale Identifier 1033
Network Address
Metwark Library
Packet Size 4096
| Password
Persist Security Info False 4
Replication server name c...
Tag with column collation ... False
Use Encryption for Data Falze
lUse Procedure for Prepare 1 w
Edit Value...
0K Cancel Help

4. Left double-click on the Persist Security Info parameter (4).
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5. Set the parameter value to True (5).

Edit Property Value

Property Description
Persist Securty Info

Property Value 5

True e

Reset Value 6 Cancel

6. Click OK (6).
7. Click OK on the Data Link Properties window to update the settings and close the window.
8. Click OK in the IDB utility window to save the settings.

As a result, the next time you switch to the selected database, the settings for connecting to it will not be reset.
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Working with idb.exe utility with the use of keys

It is possible to run idb.exe utility with keys. For this click Start Run. Type the path to idb.exe utility and the required key after / in
the appeared window.

Type the name of a prograrn, folder, documnent, or Internet
resource, and Windows will open it for you.

Open: C:\Program Files (x86)\Axxon PSIM\idb.exe /update] v|

0]4 Cancel Browse...

To display keys, supported by the utility, use the command «idb.exe /?».

Usage: idb.exe /key
! key:
fupdate -silent update [using intellect.dbi)
frepair - silent repair [using intellect.dbi)
fsync - synchronizing with data source
/backup - backup Intellect database
/backup -protocol - backup database without table Protocol
frestore - restore database
Jset_cs "key=value” - save to registry connection string
fsgl_convert:db_name mssql2000[mssql2005 - convert M5
Access database to M5 SQL Server 2000/2005

idb.exe utility supports the run with the following keys:

1. «/update» — the key of running the hidden updating of database (uses psim.dbi file).

«/sync» — the key of database synchronization with the source of data.

3. «/backup» — the key of running the process of creation the backup copy of Axxon PSIM database. Use the -protocol option to
exclude the Event protocol database from the backup (i.e., the full command in this case would be: /backup -protocol).
The backup copy is created to the address «C:\Users\user\Documents\Axxon PSIM». It is used when the idb.exe utility is
connected to MS SQL database.

4. «/restore» — the key of running the database recover from the previously created backup copy. It is used when the idb.exe
utility is connected to MS SQL database.

5. «/set_cs key=value» — the key of saving the connection string to the system registry (summary on parameters of connection
to database).

N
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Extracting event protocol into an individual
database

External event protocol is created with the help of the idb.exe utility.

1 Attention!

If Time and Attendance module is in use (the module is a part of ACFA PSIM subsystem) use the RemoteProtocolConnector

utility to extract event protocol into a separate database - see Axxon PSIM Web Report System. User Guide (the most recent
version of this document is available in AxxonSoft documentation repository).

@ Note

To operate the Report System, which is a part of base Axxon PSIM, the method of extracting the event protocol into a
separate database is used. The method is described in this section, i.e. using the idb.exe utility. Configuration of the
connection to such protocol DB is required in the Report System, which is a part of base Axxon PSIM (see Connecting to the

Events Log (PROTOCOL table)).
It is necessary to create the protocol database beforehand with the help of the MS SQL Server program. Do the following:

1. Open Microsoft SQL Server Management Studio Express;
2. Select Databases.

|.’5; Microsoft SOL Server Management Studic
File Edit Niew Tools Window Help

- | ?ﬁ' - u“|glzg'lﬁew{luer}r E |

| | Execute

Object Explorer - 1 X

Connect= ¥ ¥ O
= ﬁ WSTWSOLEXPRESS2014 (SOL Server 12.0

- System Databases
g psim
| g titles
Security
Server Objects
Replication

H FH H

[+

Management
= 5] XEvent Profiler

3. Right-click and select New Database...
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4. Specify the protocol database name in the Database name line in the New Database dialog box.

B Mew Database — O x
o a T o - Qo
& Options
& Filegroups Database name: |Drotocol| |
Cwner: |cclefa|.||t> |
Database files:
Logical Name  File Type  Filegroup itial Size (MB)  Autogrowth / Maxsize R
protocal ROWS... PRIMARY | i By 1 MB, Unlimited =
protocol_log LOG Not Applicable By 10 percent, Unlimited | ... | (
Connection
Server:
WST\SQLEXPRESS2014
Connection:
WST\COMPUTER
ﬁ Miew connection properies
Progress
Ready < >
Add Bemove
Cancel

5. To create a new protocol database, click the OK button.
6. Shut down Microsoft SQL Server Management Studio Express by clicking the Close button in the upper right corner of the
dialog box.

As a result, the protocol database is created.
To enable the external event protocol, do the following:

1. Run the idb.exe utility (see Running and shutting down the utility).
2. Select the Protocol database from the Select source database drop-down list.

Select data source:

Basic data w

Basic data
Autoparking
Detectorpack
Face

License plate numbers database
monitorssty
POS

Protocol
Synchro source
Titles

Traffic
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3. To enable the Protocol database, set the Use checkbox (1).

4 1DB - [ws1] = bl
Select data source: Description:
Protocol “ | | "Axxon PSIM” zystem's external protocols database
[use 1 : 2
Connection string: Move datahase
| Digabled |
Select dbi-file: Select ddi-file:
| C:\Program Files (x86)\Axxon PSIM\psim. dbi | = ‘ C:\Program Files (x86) Wxxon PSIM\Languages\en\psim. ddi =
Select action
Create backup copy (M5 SQL) Restore from backup (M5 SQL)
Clear protocols
Additional tools 3
Update database Create dbi-file
Protocol

4, As a result, the Configure button becomes active (2). To connect to the Protocol database, click the Configure button.
5. As a result, the Data link properties dialog box appears. Go to the Provider tab.
6. Select the Microsoft OLE DB Provider for SQL Server from the OLE DB Provider(s) list (1).

EF| Data Link Properties X

Provider Connection Advanced Al

Select the data you want to connect to:

OLE DB Provideris)

Microsoft Jet 4.0 OLE DB Provider

Microsoft OLE DB Driver for SQL Server

Microsoft OLE DB Provider for Analysis Services 14.0
Microsoft OLE DB Provider for ODBC Drivers
Microsoft OLE DB Provider for Oracle

Microsoft OLE DB Provider for Search

Microsoft OLE DB Provider for SQL Server
Microsoft OLE DB Simple Provider
M5DatasShape

QLE DB Provider for Microsoft Directory Services
S0L Server Mative Client 11.0

2 [ ]

OK || Cancel || Hebp

7. Click the Next button (2).
8. You will be automatically redirected to the Connection tab.
9. Do the following in the Connection tab:
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a. Select a server name from the Select or enter a server name drop-down list (1).
£ | Data Link Properties >

Provider Connection  Advanced Al

Specify the following to connect to SGL Server data:
1. Select or enter a server name:
1 |WS1 \SOLEXPRESS2014 ~ || Befresh
2. Enter information to log on to the server: .
() Use Windows NT Integrated security
(®) Lze a specffic user name and password:

2 Lser name: |sa |

Password: |----------------- |
[ ] Blank passward Allow saving password 7§
3. (®) Select the database on the server:
4 |protn:|cnl e |
() Attach a database file as a database name:

protocol

|lzing the

Test Connection 5

ﬁ- Cancel - I-ielp

b. Specify the user name in the User name field and specify the password in the Password field (2).
c. Set the Allow saving password checkbox (3).
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d. Go to the All tab.
[] | Data Link Properties X

Provider Connection Advanced| Al

These are the intialization properties for this type of data. To edit a
value, select a property, then choose Edit Value below.

Name Value oy

Inttial File Name

Integrated Security

Locale |dentifier 8192
Network Address

Network Library

Packet Size 4096

Password :
WPecst Secutyiho___Twe ]
Replication server name c... :
Tag with column collation ... False

Use Encryption for Data False

Use Procedure for Prepare 1

User ID sa v

Edit Value...

oK Cancel Help

e. In the Persist Security Info field, set the True value. This is necessary to correctly save the user password.

{D Note

Each time you change the server connection parameters, you must set the Persist Security Info field value
to True.

f. Select the protocol database in the Select the database on the server drop-down list (4).

g. Click the Test connection button (5).

h. If the connection to MS SQL Server is successfully established, then the Test connection succeeded message
appears.

Microsoft Data Link o

o Test connedction succeeded.

i. Click the OK button in the message box. The box closes automatically.
10. Select the dbi file. Click the button next to the Select dbi-file information field.
11. As a result, the Open dialog box appears.
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12, Select the database structure file - C:\Program Files\Axxon PSIM\protocol.dbi.

| Intellect Buile
Extracting event.
General informa

‘s Local Disk (C2)

Starting and shu
@ OneDrive
[ This PC

F Network v

£ save As X
+ » ThisPC » Documents » Backup v | O Search Backup P
Organize ~ New folder Eotew (7]
[ Desktop A Name Date modified Type Size
4 Downloads [ protoceldbi DB File 0 KB
| Documents
&= Pictures

File name:

Save as type: | DEI Files (*.dbi)

~ Hide Folders

Save

Cancel

13.
field.

Click the Update database button to update the database in accordance with the psim.dbi file

4 DB - [ws1]

Select data source: Description:

X

Protocol w

Use

Connection string:

“Axxon PSIM™ system's external protocols database

Move database Configure

| Provider=SQLOLEDE. 1;Password="*=;Persist Security Info=True;User ID=sa;]

Select dbi-file: elect ddi-file:

| C:\Program Files {x86)\Axxon PSIM'psim. dbi | =

C:\Program Files {x86)\Axxon PSIM\Languages'en\psim.ddi =

b

Select action
Create backup copy (M5 SQL) Restore from backup (M5 SQL)

Clear protocols

()

E Update database Create dbi-file

)

Protocol

File C:\Program Files {x86)\Axxon PSIM\Languages\en'psim. sia.ddi is loaded successfully
(i) File C:\Program Files (x36)\Axxon PSIMILanguages\en \psim. sip. ddi is loaded successfully
) File C:\Program Files (x86)\Axxon PSIM\Languages\en'\psim. statestat. ddi is loaded successfully
L i) File C:\Program Files {x36)\Axxon PSIMYLanguages|enpsim. telegram. ddi is loaded successfully
(i) File C:\Program Files (x86)\Axxon PSIM\Languages\en'\psim. tss. ddi is loaded successfuly
(i) File C:'Program Files (x86)\Axxon PSIMILanguages\en'\psim. videopsimdient, ddi is lnaded successfully
(i) File C:\Program Files (x86)\Axxon PSIMILanguages\en\psim. web, ddi is loaded successfully
iJFile C:\Program Files (x86)\Axxon PSIM\Languages'\en'psim, webworktime. ddi is loaded successfully

xxon PSIM\Languages\en\psim. yitu.ddi is loaded successfully
{ |¥)Data Updating is completed!

<

L 4

p—tm,

specified in the Select dbi-file

14. As a result, database updating will start. Information about this process is displayed in the Protocol table.
15. Database is updated, when there is the Database Updating is completed! message in the Protocol table.
16. To save Axxon PSIM connection parameters to the Protocol database, click the OK button. As a result the dialog box closes

automatically.

External event protocol is created and connected.
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Creating the database backup copy

To create the MS SQL database backup copy, use the idb.exe utility. To create the backup copy, do the following:

1. Run the idb.exe utility (see Running and shutting down the utility).
2. Select the Basic data MS SQL database from the Select data source dropdown list.

(D Note

Select the vertical solution database to create a backup copy of the vertical solution database. For example, for Face
PSIM the data source is Face.

3. If it is not required to include the Event protocol in the backup copy of the database, set the Clear protocols checkbox. This
checkbox is not available if the vertical solution database is selected.

4. Click the Create backup copy (MS SQL) button.

5. As a result, the Save as dialog box appears. Select the address and type in the name of saving backup copy.

"] savehs

T < Program Files (... » Axxon PSIM » v (4] Search Axxon PSIM 2
Organize » Mew folder sEEt 9
[ This PC (a Mame Date modified Type A
_J 3D Objects Applications 2 File folder
I Desktop Bmp 2 File folder
Iﬂ Documents Help 2 File folder
Htm 2 File folder
; Downloads i
Languages 2 File folder
J’ Music Languagestd 02 File folder
=] Pictures Modules 23 File folder
B Vvideos Moduleséd 23 5 File folder
= 55D (C:) Program 12/26/2022 414 PM File folder
Redict A/I57N27 A PhA Fil= fnlder b
= HDD (D:} il >
FIE T R Rpsim [DESKTOP-7932GG9] 2023-01-15 18-57-56.ba ~
Save as type: | Backup files(*.bak) o
A Hide Folders Cancel

(D Note

While creating the MS SQL database backup copy, the created backup copy will be saved on the computer where the
database server is installed, in case of Axxon PSIM software and database server are located on different computers

connected through the network. To save created backup copy on the computer where Axxon PSIM is installed, do the
following:

a. Create the folder available through the network on the computer where Axxon PSIM is installed. Provide
access to the created folder from the computer where the database server is installed.
b. Specify the path to the created folder in the Save as window.
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6. As a result, the process of backup copy creation starts. Information on this process is given in the Protocol information table.
'y, IDB - [DESKTOP-7932GG9]

Select data source: Description:

Basic data ~ | "Axxon PSIM" main database:
Use

Connection string: Move database Configure

| Provider =SQLNCLI11. 1;Integrated Security=55PI;Persist Security Info=False;1

Select dbi-file: Select ddi-file:
| = ‘ C:\Program Files (x86) \Axxon PSIMYLanguages\en\psim. ddi =
Select action
I Create backup copy (M5 SQL) I Restore from backup (M5 SQL)
[ clear protocols
Additional tools
Update database Create dbi-file

Protocol

() File with backup copy: C:\Program Files (x86)\Axxon PSIM\psim [DESKTOP-79326GS] 2023-01-15 18-57-56.bak

(i) Creation of a backup copy of base [psim] in C:\Program Files (x85)\Axxon PSIM\psim [DESKTOP-7932GGY] 2023-01-15 18-57-56.bak in progress, wait...!
\f)Creaﬁon of a backup copy is completed!

OK

7. The backup copy is created when the Creation of a backup copy is completed! message appears in the Protocol table.

@ Note

The backup copy (MS SQL) can be created using the macro.

8. Click the OK button. The dialog box closes automatically.
The MS SQL database backup copy is created.

By default the database backup copy is created at: C:\Documents and Settings\<user name>\My documents\AxxonSoft\Axxon
PSIM\Data\psim.sql.bak. In case you cannot change the folder for storing the database backup copy while the backup copy creation,
do the following:

1. Call the Run function (Start Run). Type in regedit in the opened dialog box.

2. Click the OK button. As a result, the Registry editor dialog box opens.

3. Create the string parameter with the BackupFolder name in the HKLM\SOFTWARE\AxxonSoft\PSIM registry thread (see Adding
string parameters to the registry).

4. Set the value of the BackupFolder parameter: type in the address of the folder for storing the database backup copy (e.g. C:
\Documents and Settings\AVP\Desctop\Backup).
If it is necessary to store the database copy on the network disk, then the UNC path to the network folder (with the recording
access) should be specified on the disk in the \\ServerName\ShareName format. Take into account that all network resources
that require additional authentication should be connected using the same username as for running the SQL Server service. To
find out and/or change the user that runs the SQL Server service, do one of the following:

a. Using the SQL Server Configuration Manager utility.
b. Run Start — Control panel - Administrative tools - Services, right-click the SQL Server service and select Proper
ties in the feature menu. In the opened SQL Server service dialog box, go to the Log On tab.
5. As a result, the string parameter of the key with the specified value is created.

3 Registry Editor

Fle Edit View Favorites Help
Computer\HKEY_CURRENT_USER\SOFTWARE\AxxonSoft\PSIM
~ || SOFTWARE || Name Type Data
Adobe e u[ anbal
ﬁs:i:?;g: e REG_SZ C:\Program Files (x36]\Axxon PSIM ]
~ | AxxonSoft
i DD Editor
[ Y
i Debug

6. Call the Run function (Start Run). Type in the «C:\Program Files\Axxon PSIM\idb.exe /backup» key in the opened dialog box.
7. Click the OK button.
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As a result, the psim.sqg.l.bak database backup copy is created in the folder specified as the value of the BackupFolder parameter.
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Restoring database from backup copy

The database backup copy is created using the idb.exe utility (see Creating the database backup copy). Database restoring from
backup copy is also performed using the idb.exe utility in the following way:

1. Run the idb.exe utility (see Running and shutting down the utility).
2. From the Select data source: drop-down list select the MS SQL database - Basic data.

(D Note

Select the vertical solution database to create a backup copy of the vertical solution database. For example, for Face
PSIM the data source is Face.

3. Click the Restore from backup (MS SQL) button (1).

A 108 - [ws1) e %
Select data source: Description:
Basic data ~ | | "Axxon PSIM" main database
Use

Connection string: Move database Configure

| Provider=SQLNCLI11. 1;Integrated Security=55PI;Persist Security Info =Fa|se,'I|

Select dbi-file: Select ddi-file:
| C:\Program Files (x86)\Axxcon PSIMpsim. dbi | = ‘ C:\Program Files (x86)\Axon PSIM\Languages'en\psim. ddi =
Select action
Create backup copy (MS SQL) | Restore from backup (MS SQL) I 1

[ clear protocols

Additional tools

Update database Create dbi-file

Protocol
{i)Restoration of base psim from a backup copy C:'psim [WS1] 2022-08-18 11-58-34.bak in progress, wait
@Restoraﬁon from a backup copy is completed!

3 oK

4. Using the standard dialog box for opening files, select the created earlier file with database backup copy.

5. As a result, the process of database restoring from backup copy will start. Information about process is displayed in the Protoc
ol informational table (2).

6. Restoring is completed when the Restoration from a backup copy is completed! message will be displayed in the Protocol
table.

7. To finish the work click the OK button. The window will close automatically (3).

Database restoring from backup copy is completed.
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